
ISSUE 13  • MAY 2006The First and Only Magazine for the New LINUX User

TUX EXPLAINS Free your mind and creativity with Freemind Change Your 
Perception of Linux!

Linux’s Fundamental 
Difference

THIS MONTH MANGO PARFAIT:
• Tames a wildly incorrect panel clock
• Changes the system configuration for a new PS/2 mouse
• Solves the case of the unexpected server shutdown

LINUX HELPS YOU 
GET THE JOB DONE
Managing finances is a critical task for millions of small businesses. In this issue, 
TUX shows you how to migrate off Quickbooks with Linux and Appgen MyBooks.

Reviews:
• Gadget Guy Takes a Few Digital Cameras for a Swim

• We Check for Hype When Using Skype

• Ending the Day with a Round of Virtual Putt Putt

F-SPOT
Many Small Businesses Rely on Photographs 
for a Variety of Activities. Let F-Spot Lead 
the Way to Productivity

SCRIBUS DESKTOP PUBLISHING
We Show How It Can Help Your Business 
Deliver the News

FIRESTARTER
Get the Most From Your Internet Connection and 
Protect It at the Same Time



53 Neverputt

CONTENTS
P2P

3 T h e  R i g h t  To o l ?
P H I L  H U G H E S

5 L i n u x ’s  F u n d a m e n t a l
D i f f e r e n c e
K E V I N  S H O C K E Y

7 L e t t e r s

1 5 T U X D e l i v e r s  t h e  N e w s
K E V I N  S H O C K E Y

1 7 Q & A  w i t h  M a n g o  Pa r f a i t
M A N G O  PA R FA I T

HOME PLATE

21 F - S p o t
J E S  H A L L

SUITED UP

24 M a n a g i n g  S O H O B u s i n e s s e s
w i t h  A p p g e n  M y B o o k s
P r o f e s s i o n a l
D O N A L D  E M M A C K

29 I m e n d i o  P l a n n e r  a n d
Ta s k J u g g l e r : a n  O v e r v i e w
J E S  H A L L

TUX EXPLAINS

32 A t  5 , 0 0 0  F e e t : U s i n g
S c r i b u s  t o  P u b l i s h  a
N e w s l e t t e r
D O N A L D  E M M A C K

36 F r e e M i n d
D A N I E L  B A R T H O L O M E W

41 E x p a n d  Yo u r  R e a c h  w i t h
We n g o P h o n e
D M I T R I  P O P OV

45 I n t e r n e t  C o n n e c t i o n
S h a r i n g  w i t h  F i r e s t a r t e r
K E V I N  B R O W N

DIVERSIONS 

5 3 Neverputt
J O H N  K N I G H T

ISSUE 13

MAY 2006

REVIEWS

47 W i t h  S k y p e ,  t h e  W h o l e
B u s i n e s s  Wo r l d  C a n
Ta l k  f o r  F r e e
J AY  K R U I Z E N G A

51 T h e  G a d g e t  G u y :
I n t o  t h e  D r i n k
• Pe n t a x  O p t i o  W P i
• O l y m p u s  S t y l u s  7 2 0  S W
S E A N  C A R R U T H E R S

21 F-Spot

24 Appgen MyBooks Professional

2www.tuxmagazine.com

NEXT MONTH
• Konqueror and KIO slaves 

dominate file access.
• TUX creates pages for the Web 

with Bluefish and Nvu.
• Learn a new language with help 

from Linux, jVLT and StarDict.



I have been watching a discussion on the Scribus
mailing list. It started with a description of a teacher
who elected to teach open-source tools instead of
more traditional desktop publishing tools—in other
words, proprietary tools.

After you filter out those that support his 
decision and those that suggest it was bad
because those tools aren’t what is used in industry,
you get to the point made by a contributor
named Roger: “Open source and its tools are in
an infancy and growing faster than imaginable;
however, it will never be the right tool for every-
body, just like proprietary software is not the
right tool for everybody.”

Okay, he gets it—people use what works best
for a given purpose. But, as true as his statement
is, we have to consider the politics as well. Thirty-
plus years ago, the common expression in IT was,
“You can’t go wrong buying IBM.” Well, although
IBM is a big player in the Linux community today,
there certainly was a time when people would dis-
agree with that statement.

Let’s look at UNIX. UNIX grew in market share,
and ten-plus years ago, people knew Linux was
only a toy and UNIX was the one true POSIX-
compliant operating system—another “truism”
that went away.

I just read that Microsoft announced support
for Linux running under its Virtual Server 2005 R2.
First, let me explain what Virtual Server is. It is a
product that runs on top of Microsoft Windows
that allows you to run other operating systems (in
Microsoft’s case, up to four), as if they were run-
ning on the hardware itself.

Now, why would someone want to run Linux
in such an environment? If we take that expres-
sion from more than 30 years ago and make a
one-word change, we get, “You can’t go wrong
buying Microsoft.” So, you tell your boss you are
running Microsoft, and he is happy, and you run
Linux on top of it to keep your programmers
happy. Does that make sense?

Well, no. Here is the problem. The way
Microsoft Virtual Server works, it will be slow.
This is partly because it doesn’t take advantage
of built-in capabilities for virtual systems in the
newer AMD and Intel processor chips. Clearly
Microsoft knows this, because it also just reduced
the price to $0. That’s almost like free software,
but without the benefit of being able to see what
is inside or the ability to modify it.

Why is Microsoft being so nice? It sees the
writing on the wall. VMware and XenSource offer
these same capabilities and do it a lot better. In
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fact, the Xen product will be included with the latest SUSE
and Red Hat enterprise editions of Linux. That is, you can
buy Linux, install it, and if need be, run Microsoft Windows
on top of Linux.

So, Microsoft isn’t giving away the farm. It is trying to
keep people from defecting to the superior solutions avail-
able today, while it tries to get its product up to snuff with
the competition. You still have to buy the operating system,
and Microsoft hopes you will buy a support contract for its
now-free Virtual Server product. Once again, Microsoft
wants you to see it as the right tool for the job—even if it 
is only politically right.

Another feather in the Linux cap was the announcement
that Linux Professional Institute and Canonical, Ltd.—the

people behind Ubuntu Linux—have added Ubuntu profes-
sional certification. This puts a little more of the good poli-
tics into the Linux camp.

Where am I going here? First, I want to say that Linux
today is about as mainstream as you can get. I guess I would
think of it as the Toyota of the US car market. Although at
one time many people were busy telling us that Japanese
cars didn’t really work, Toyota and others continued to gain
market share.

So, what matters today is will Linux do the job you want
done? On the plus side, Linux does, and always has, interop-
erated with other operating systems. Depending on your
environment, a Linux-based server might be the best first
step whether the clients are Microsoft-based, Mac-based or a
combination—and maybe a Linux desktop added to the mix.

Where you decide to add Linux to your computing mix is a
decision for you to make. The only real mistake you can make
is to think that Linux will not be a serious mainstream player.�

Phil Hughes is Group Publisher for SSC Media Corp.
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My wife and I played host to a senior
executive from a major nonprofit recently,
and as I was explaining what I was work-
ing on, he asked a question that stumped
me. It was really a simple question, but I
had never heard it put in quite this way.
After telling him that I was working on a
magazine focused on Linux and explain-
ing that it was an alternative to Microsoft
Windows, he asked, “What is the funda-
mental difference from Windows?”

Obviously, many things immediately
jumped to my mind. Well, I thought, it is
typically cheaper, it is more secure, it pro-
vides more freedom, it suffers from fewer
virus attacks, and it is supported by an
active and knowledgeable community.
However, I didn’t really feel comfortable
with any of these, or anything else I could
think of on the spot. Although all of
those reasons are important, I didn’t think
this nontechnical, attention-deficit-chal-
lenged senior executive would get these
overly technical reasons. Plus, I also

believed that it was the combination of
all of them, plus others that made Linux
fundamentally different. To make matters
more confusing, I knew from working
with senior executives before that their
tolerance for jargon and patience in hear-
ing “the point” meant my answer needed
to be simple and short. Ask a simple
question, get a simple answer, right?

Unfortunately, I muddled through
with an answer that I ended up not
being happy with, and vowed to boil
down the many reasons to one funda-
mental difference. I did much better
when explaining OpenOffice.org. When
he asked why should his company con-
sider OpenOffice.org, I said, “It’s free!”,
which seemed to get his attention. It
was also something he immediately
could understand.

As the weeks went by after my
encounter, I kept thinking about the one
fundamental difference between Linux and
Windows. Finally, after significant subcon-

scious processing, it became clear. For me,
the fundamental difference (and I believe
the most profound) difference is...control.
After a long trend where makers of soft-
ware assumed more control over our desk-
tops and applications, I believe that free
and open-source software, especially Linux,
restores control back to us, the owners of
those desktops. Stepping back, the wider
perspective of control also allows me to
include the many other important benefits
within one larger single difference. By
encompassing all of the other reasons why
Linux is different, control suffices to keep
the answer short. However, then I have to
fit the other major reasons under the
umbrella of control.

CONTROL OVER COSTS
With low or no licensing costs, we can
get Linux, use it as much as we want,
and even share it with our friends. In
addition, because the total cost of own-
ership is lower as well, we have greater
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control over the upwardly spiraling costs
of proprietary software.

CONTROL OVER HARDWARE
With numerous distributions available,
Linux provides more control over imple-
menting an operating system and soft-
ware that meets our needs, while still
using our existing hardware infrastruc-
ture. We can expect to implement new
versions of our favorite distributions, or
even choose a replacement distribution,
and reasonably expect to avoid upgrading
our hardware to make the new version
work. This also helps control our costs.

CONTROL OVER SUPPORT
In my opinion, less support available for
Linux and open source is the biggest myth
ever. Linux and open source have two
sources of support that proprietary software
cannot match. First, if you have the desire,
you can access the original source programs
and provide your own support. Want to
know why a piece of code is failing? What
not debug it yourself? Second, between a
large community of supporters and develop-
ers, nearly all projects have extremely talent-
ed and dedicated resources ready to help.
One of those community members even
might be the engineer who actually wrote
that particular piece of code. Compare that
with wasting your time on first and second

tier support, waiting to talk to an engineer—
who, when you finally contact that engineer,
says she can’t help you because she was
unable to replicate the error in her laborato-
ry. Everyone knows that if one can’t replicate
the error, one can’t fix it!

CONTROL OVER VIRUSES
For the time being, Linux enjoys relative
immunity from viruses, spyware, adware
and malware. This is partly because most
everyone follows standard security practices
and runs Linux with a user account and not
the superuser root account. And, it also is
partly due to the amazing process inherent
in developing open-source software that
permits developers, testers and users (the
community) to examine the source code
and find more errors, which also allows the
community to patch emerging security vul-
nerabilities more quickly.

CONTROL OVER FUNCTIONALITY
If you are not happy with how Linux does
something, and you have either the ability or
the motivation to contribute to make it work
differently, then you have control over the
functionality of Linux. Because of the
General Public License, you have the right to
modify the original Linux source programs. If
you desire, you can obtain all of the original
source programs and create a copy of Linux
just for you, your company or your country.

And, also because of the GPL, no one ever
can take that away from you. Put in those
terms, it is easy to see why Brazil and China
want to use Linux so extensively.

CONTROL OVER THE SOFTWARE
Because Linux is available only by agree-
ing to the end-user license agreement,
the General Public License guarantees
that Linux will always be available to us.
No entity can prevent our access to Linux
and the source code for Linux. Many use-
ful and important software applications
are no longer available to us because the
owner of the software did not release the
software into the public domain prior to
going out of business.

Considering it in this way, it is easy to
see why the main difference between Linux
and Windows is control. The more freedom
we receive with Linux ultimately means
more control. With Linux, we are in com-
plete control of our computers; we’ll decide
what to run and when to upgrade. We’ll
modify our computers by writing or fixing
programs if we are able, and we’ll choose
when to upgrade our hardware and gain
even more security from attack. For those
of us that have suffered by having some-
one else control our computers, the control
Linux affords is refreshing and liberating.�

Kevin Shockey is Editor in Chief of TUX.
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Constructive Distribution Smackdown Criticism
I am sure that my mail will be among hundreds of messages
pouring in your inbox as far as the choice for the distro is con-
cerned [April 2006]. Frankly, I have tried and tested some three
distros before I settled in with Ubuntu as my distro of choice.

There can be many arguments for and against a particular dis-
tro. However, I feel that even though Ubuntu may be heavily
promoted and advertised, it gets the job done. None of the
reviewers highlighted the fact that Ubuntu 5.10 now comes
with Automatix (which is mentioned on the Ubuntu Wiki and
the forums), which makes it a breeze to install the non-free soft-
ware in association with the Penguin Liberation Front. One does
have to open up the terminal, but the step-by-step guide makes
it a breeze to install it initially and watch the screen roll as it
updates and installs the codecs, Flash, firewall and so forth.

I am a novice user. Arguably, I have been miffed with some lack of
support on the Ubuntu forums or in the IRC channels, but the
world isn’t perfect, is it? There are some nagging hassles with
KDE 3.5.1 too, but on the whole, my job gets done. While using
Linux, people do have to involve themselves with the distro; I am
speaking this as a newbie, mind you! It isn’t about tweaking or
command-line stuff, but Linux does demand a little intelligence.

I believe that the next distribution comparison should include simi-
lar hardware across categories. With differing hardware, it isn’t
fair to rate the distros. Otherwise, most of them run on a range
of hardware, depending, of course, on the graphical environment.

I have issues with Mandriva too. It may be free to download,
install and use, but as a newbie, I need to use urpmi to down-
load the “latest”. The primary reason I shifted to Linux was

because it is free. And this means freedom from licenses or any
future upgrades. Ubuntu even ships for free to my doorstep. All
I need to do is to place an order on-line. Why do I have to pay
for printed manuals when everything is free on-line? Someone
who needs the manuals to get it done, needs help for sure.

I come from a resource-poor setting. Internet availability is a
mess, and it’s next to impossible to get decent broadband.
Under these circumstances, I find Ubuntu makes sense, especially
for a country like India. It is not flashy with blinky installers
either—a basic text-based system does the work.

A major hassle with Linspire is that it runs the whole distro as
root, which makes it vulnerable to insults. Again, I have issues
with paying for free software. I would never touch Linspire with
a barge pole—never.

One more point of concern is in the review of Linspire, the
author maintains that he doesn’t have to call up India and be on
hold for an hour. Outsourcing is a contentious issue here too. By
other accounts on-line, Linspire support is patchy at best, and
there are several posts on-line deriding them—even from the
call centres based in the country of their origin. I am sure that
these subjective biases could be done away with.

The most important fact is that there ought to be a disclaimer
of the interests of the reviewers—whether any of them have
profited from the exercise. These “interests” ought to be
declared in the spirit of open source, or else anyone would
be tempted to question the motives behind using the distro
and recommending it over others.

Before I end, SUSE is a great distro. However, the RPMs can be a
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pain to handle. Newbies, those who don’t understand adding
repositories, can mess up their systems by downloading RPMs
that may not be packaged correctly. It’s the equivalent of down-
loading .exe files. Synaptic doesn’t let any Deb file install by
itself and usually removes it as a broken package. I would
wholeheartedly recommend klik, which does away with the
installation hassle on its own. It isn’t perfect, but it works most
of the time. This factor could have been highlighted as well. It
wasn’t, and this makes it a very incomplete smackdown.

I hope that you take all of this as constructive criticism. Overall, I
love TUX magazine for its no-nonsense approach toward Linux
for newbies.
—
Dr Abhishek Puri

Thanks for the feedback and I respect your opinions concerning
our comparisons. Unfortunately, we don’t have the resources
to carry out a more controlled review with exactly the same
hardware. I’m concerned, however, with your implication
that the freedoms provided by the General Public License
and other open-source licenses equal free of cost. Nothing
could be further from the truth. It states very clearly on the
Open Source Initiative Frequently Asked Questions Page
(http://www.opensource.org/advocacy/faq.php) that you can sell
open-source programs. You are entitled to your right not to buy
software—or books, training or anything else related to open
source—that is your choice. Nevertheless, I believe that by not
buying these things or supporting open source in some other
fashion—donation of money, resources or time—we jeopardize
its strength and long-term viability. Free and open-source soft-
ware is not without a license; when you use this software you
agree to that license. That license ensures the freedom to

distribute, modify and remain available (among other freedoms).
None of those licenses indicate a freedom from costs.—Ed.

A Strong Reader Endorsement 
for Brother Printers
This is the first time I’ve sent an e-mail to you guys. The maga-
zine is fantastic! I’ve read every issue. I’ve noticed several read-
ers’ letters have included complaints about Linux drivers. I’ve
been using Linux since 1996 or 1997. I’ve found, with Linux, to
have a great system is to make sure you buy hardware that you
know is compatible, at least until everybody makes drivers for
Linux. Also, regarding printers, if you don’t have one already,
buy a Brother printer. Brother has Linux drivers for all its prod-
ucts on the Web site. Also, some distributions have certain driv-
ers that others don’t. Look into the distro and try to find out
whether it covers the drivers you’ll need. Anyway, thanks for the
magazine. I’m not a newbie, but I still learn something every
time I read your magazine.
—
David A. Tigue

SUSE Deserved a Better Score in the Smackdown
First, I want to say that I really enjoy your magazine. I have to
admit though, I was a little discontented with the distribution
smackdown for a particular reason. I’m a SUSE user and feel
that SUSE’s score was way too low for the performance
described in the test. The problem was that each distribution
was tested by different users, and whereas some users were
giving away high grades easily, others appeared to be more
strict. The SUSE tester especially seemed to be one of the
strictest. Maybe next time you should have a few testers
that have to test different distributions in order to make 
the test more objective.
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Apart from that, I really enjoy reading every issue. Maybe you
could do a special article about the KDE killer app amaroK
[see TUX’s first issue for an introduction to amaroK]. There’s a
new version coming out soon (1.4), and it will surely deserve
the attention. Keep up the good work, and don’t let Mango
Parfait change her style.
—
Jens Uhlenbrock

Ubuntu Deserved a Better Score Too
I wanted to add some feedback to the April 2006 Distribution
Smackdown issue. I found the articles overall to be well done
and informative. The only problem I personally found was some
of the reviews seemed incomplete on some fronts, specifically
the Multimedia section in the Ubuntu article. Ubuntu, being a
Debian derivative, has the same capabilities to add multimedia
playback as Mepis and Debian itself, by either installing the
packages manually or by using apt-get. The Win32 codecs,
livDVDcss2 and RealPlayer can be downloaded from any number
of sites, including http://videolan.org and the MPlayer home
page, as Deb packages or source. After that point, it’s only a
matter of switching the gstreamer versions of amaroK, Totem
and Kaffeine for the Xine versions using Synaptic/Adept.
After that, you can play any multimedia format in Linux that
you can in Windows.

For a much easier install, simply adding the PLF repository to the
sources.list file (only two lines of text), allows all of the above to
be downloaded via Synaptic/Adept. Switching the gstreamer
versions of amaroK, Totem and Kaffeine for the Xine versions is
still required.

All in all, I love TUX Magazine so far, as well as its counterpart.

Keep up the excellent work. I’m sure you will be getting a lot of
these messages, as any article regarding distributions usually
spawns a lot of feedback—some constructive, some negative. 
I hope mine comes across as intended, constructive.
—
Aaron Salyers

A Potential Solution for Storing Passwords?
We all know that storing passwords (even in encrypted form) is
insecure. But a new open-source project called PasswordMaker
(http://www.passwordmaker.org) helps you remember your pass-
words without storing anything. A unique digital fingerprint is
created by hashing your “master password” with the URL of the
login page. PasswordMaker then automatically recalculates the
digital fingerprint at every login.

From the Web site: “Nothing is stored anywhere, anytime, so
there’s nothing to be hacked, lost or stolen.”
—
Phillip

Doubts over Mandriva Review
Although I’m sure that Mandriva is a fine distribution, I believe
that the article on it in your Distribution Smackdown failed to
prove anything significant. Unlike the other authors, Mr Leibovitch
fails to explain each of the categories set out at the beginning.

He mentions that for upgrades, “the Mandriva system can still
be fairly intimidating to new users.” He also states about instal-
lation, “I consider it a real shortcoming in Mandriva.” Yet he
gives it high marks for both.

Apparently, having up-to-date software is not a particularly
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important criteria either: “I find that Mandriva is not as bleeding-
edge as some other distributions—for instance, the current
version of Firefox as I write this is 1.5.0.1, but the one currently
supported by Mandriva is 1.0.6.” I don’t know what other soft-
ware versions are available, but I’d hardly refer to Firefox 1.5 as
“bleeding edge”—some important security changes were
brought about between 1.06 and 1.5.

Personally, I’ve downloaded (or bought) and tried quite a few
distributions. They include distributions ranging from College,
Damn Small Linux, Debian, Fedora, Knoppix, Linspire, Mandrake,
Open SUSE, Puppy, Red Hat, Novell/SUSE, Ubuntu, Yellow Dog
and a couple of others I don’t even remember anymore. Some
worked well; others didn’t even install. Some were marvelously
easy to install, but impossible (for a newbie) to add programs or
do upgrades. Yes, I have my favorite and my close second
choice, but that’s not my point.

If Linux is really to overtake the desktop, it’s got to be easy to
install, easy to use, provide the functionality that the whole fam-
ily can use, and do it at a price that makes Microsoft look less
and less attractive. Personally, I’d be willing to pay a few dollars
for a distribution that lets me legally play all of my DVDs and
see all of the on-line videos I can view if I use Windows or Mac
OS. (I might note that there’s no mention of playing such media
in the Mandriva review.) And not having to learn the console
and shell commands is a big plus for most everyone.

I’m sorry, but because of the contradictions and lack of information
for most of us, I just can’t take the Distribution Smackdown review
on Mandriva seriously. I’d think Mandriva would deserve better.
—
Rod Wood

Reader Provides Advice for 
Adding Multimedia to SUSE 10.0
I’ve just read the last (April 2006) edition of TUX (which is a
great Linux magazine, by the way) and noticed the review of
SUSE Linux 10.0 (among other interesting things). I am a SUSE
Linux 10.0 user myself (I’ve used SUSE since version 9.1). I must
say that Jes Hall wrote a great review!

In her review, she complained about SUSE lacking multimedia
capabilities, so I decided to help (if I may) other SUSE users/new-
comers install these missing multimedia plugins and thus
improve overall experience with SUSE Linux 10.0.

Installation is quite easy (even for a complete Linux newbie). All
you have to do is add some Internet repositories to the YaST
Control Center. Open the YaST Control Center (by using
K→System→YaST). Click on the Installation Source category.

Here you need to add new (Internet-based) software reposi-
tories, as follows: click the Add button, and choose HTTP. In
the newly opened dialog (under the field Server Name), type
the following text:

packman.rsync.zmi.at/suse/10.0.

Press OK. If that repository link does not work, you can
choose one of the mirrors from this site:
ftp://packman.links2linux.de/pub/packman/MIRRORS.

Highlight the newly introduced source, and then click Enable, or
disable the button until the Status field for this source says On.
Repeat this with the Refresh On or Off button for the same
source, until it reads On, under the Refresh field.
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You will add three additional repositories, as follows: click on
the Add button, and choose FTP. Under Server Name, type:

mirrors.kernel.org/opensuse/distribution/SL-10.0-OSS/
inst-source-java

Click OK. Repeat the procedure for enabling and refreshing this
source as well (as explained above).

Click again on Add, and choose FTP. Under Server Name, type:

mirrors.kernel.org/opensuse/distribution/SL-10.0-OSS/
inst-source.

Repeat the procedure for enabling and refreshing this source as well.

Click one more time on Add, and choose FTP. Under the field
Server Name, type

mirrors.kernel.org/suse/i386/10.0/SUSE-Linux10.0-GM-Extra

Repeat the procedure for enabling and refreshing this source as well.

The Software Source Media dialog of the YaST Control Center
should now look similar to the one shown in Figure 1.

Click on the Finish button to exit this dialog. From the YaST
Control Center, choose the Software Management category.
After several seconds, upon updating the newly introduced
repositories, the software manager should open. Now you can
install additional packages (not only the missing multimedia
packages, but any software that might be missing on the
CDs/DVD, such as Nvu, Scribus and so on).

To install Windows codecs, in the Search field, type w32codec-all.
Check it on the right pane and choose Accept. This installs the
necessary codecs for playing Windows multimedia files. You
may want to search for the following strings: flash, for the
Flash plugins, and kaffeine-mozilla, the plugin for embedding
the Kaffeine player in Firefox. To add support for the Java
language (browser plugin and standalone Java applications),
search for java, and choose following packages: java-1_5_0-sun,
java-1_5_0-sun-alsa, java-1_5_0-sun-jdbc and java-1_5_0-sun-plugin.
You also may want to install Thunderbird properly (embed 
it in the Application menu). In the search field, type
MozillaThunderbird. You also can search for Nvu, Scribus
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and so forth, and install those packages as well, or any others
for that matter.

DVD playback support is a little more complicated to install
(and illegal in some countries). This procedure is explained
on the following Web page: http://www.thejemreport.com/
mambo/content/view/178/42. This report was written by Jem
Matzan, and apart from DVD instructions, it provides similar
information to that mentioned above.

You always can disable these newly introduced repositories if
you want, from the Installation Source category under the YaST
Control Center (highlight repository and click the Enable or
Disable button, until Enable status says Off).

I would like to express my gratitude for reading this rather
lengthy e-mail. Many regards to everyone at TUX!
—
Petar Sarajcev

Kudos for “It’s All about the Applications”
You are absolutely correct [regarding Kevin Shockey’s From the
Editor column in the April 2006 issue]. And, until applications
are simple to load, simple to run and cover the major needs of a
newbie as well as an experienced user, Windows will continue
to be the OS of choice—just too much technobabble for me.
—
Bill Parsons

Mango Has Gone Too Far!
Mango went too far when she said, “So if you are too stupid
for KDE, GNOME is perfect for you.”

I demand that she apologize for that comment and be fired!
That was totally inappropriate for her to say!
—
Jim

As Editor, I’d like to apologize for that comment. I’m responsible
for every word that goes into each TUX issue. I should have
changed that comment, but I thought it was within her rights to
think and write that. However, I didn’t exercise my right to
remove it. I should have, but I promise that I won’t let it happen
again—either from Mango or from any of our other authors.
From now on, I will strive to make TUX rise above the com-
ments that divide our community. If I slip, you most certainly can
ask for my resignation.—Ed.

Linspire Robbed of Championship Belt!
I absolutely loved the April 2006 issue and its side-by-side review
of some of the more popular Linux distributions. It contained
some very helpful information. Thank you. However, I really
question Mr John Reep’s review of Linspire. Did he really use it?
Did he really dig a bit deeper into its CNR technology? I get the
impression that he didn’t. If he did, he’s obviously coming from
the perspective of a seasoned, experienced Linux user.

Linspire doesn’t target seasoned Linux pros. Linspire reaches out
and targets the new Linux user—one who wants the ease of use
of Windows or Mac without having to know all the technical
aspects of Linux. Linspire succeeds at this through CNR.

I think a much more balanced, realistic test would have been to
give each Linux distribution to new users who know nothing
about Linux. Have Linux newbies install software, run applica-
tions and so on. I believe your results would be totally different.
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Newbies would have easily voted Linspire to be the true heavy-
weight winner.

Thanks again for a terrific Linux magazine!
—
Mark Szorady

Larger Memory Cards for the Nokia 770
Keep up the good work with TUX—it’s a great magazine and
I have learned a lot from subscribing.

Just to let you know, I have a Nokia 770 Internet Tablet, and I
use a Kingston 1GB memory card in it [see the March 2006
issue for a review of the Nokia 770 Internet Tablet]. There are no
problems, despite what Nokia says, and the Nokia support per-
son said it was not possible to use 1GB memory in the device!
I’m sorry I do not have the Kingston part number on hand, but
if you go to the site and search for Nokia 770, it comes up.

Like you, I am looking forward to further applications for this
product, and once I have upgraded my 500MHz Linux machine,
I may write some of my own.
—
Roy

Thanks for sharing this information Roy. PJ, a friend of mine,
also told me that gumstix has 512MB mini-MMC cards for $60
US plus shipping. Here’s the URL: http://gumstix.com/store/
catalog/product_info.php?cPath=28&products_id=134.

They also have 256MB for $35 US plus shipping. By the way,
MMC = SD without the encryption. But, they are otherwise
pin- and API-compatible with SD cards. Thanks PJ!—Ed.

Call for Newbie Linux Server Articles
As a Linux newbie, I have read TUX since issue 1 and have
always bemoaned the restriction TUX appears to have placed
on itself by stating it supports only the Linux desktop.

I run Linux as a server at home (Novell Linux Small Business
Server—I believe it’s SUSE Linux Enterprise Server 9). This runs
primarily as an e-mail server and firewall; however, I recently
tried running TwonkyVison Media server pushing Upnp music to
a Philips Streamium player attached to my home HiFi.

Personally, I have found the Linux desktop “a jump too far”
with my household bemoaning unfamiliarity and demanding
M$oft Windoze apps and so on, so my Linux classroom is limited
to the server, which of course, they have no knowledge of. I
have had an “interesting” time configuring various services and
have found it quite a challenge, as there is little, if any, newbie
support out there for anything other than Linux desktops. How
about some occasional items on the server side?

I know more and more people are running servers at home to
provide network services to their families. Let’s face it, Linux fits
that role admirably, and why shouldn’t TUX be a leading light
for these newbies? How about an occasional page or two on
server issues?
—
Stan Chelchowski

I think our sister magazine, Linux Journal, has done an outstand-
ing job covering all topics related to Linux servers. Our mission
at TUX is to promote widespread adoption of Linux as a desktop
operating system. If a server issue helps that promotion, you’ll
see a page or two on that subject.—Ed.
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A Call for Articles on 
Creating Web Pages in Linux
I would like to start by congratulating you on an excellent
magazine! I discovered it only about a month ago but have
since downloaded all the back issues and have read most of
them cover to cover.

I have been tinkering with Linux since about 1998, but I have
never been able to make a clean break with M$. The biggest
problem is probably my familiarity with Windows. The easy
way out is therefore usually to do something in Windows,
because I know exactly how to do it and don’t have to figure
it out first. Installation of new software also has been a
major pain with Linux. I am an advanced PC user and build
my own machines, set up networks and design Web sites.
My home network consists of Macs and PCs running a 
mixture of Linux, Windows (NT and XP) and Mac OS X.

I recently bought both Linspire 5 and Xandros desktop 3. I
must say that both of these distributions are excellent,
although I prefer Xandros. (I know you have been less than
enthusiastic about it in previous editions but it works for
me.) These distributions have come a long way in making
Linux more accessible to the general desktop user. Users
don’t want to compile, configure and hack to get something
to work, no matter how powerful the software. They want
to push a button; everything should be graphical. Mac OS X
is an excellent example. My wife is not very technically savvy,
but she was able to start up her first Mac and start working
with it straight away. Why can’t Linux be like this?

My question is actually this: what software does the Linux
community use to develop Web sites? I have been using
Macromedia’s Dreamweaver, and this is probably the last
hurdle preventing me from making a complete switch to
Linux on my development machine. I am looking for some-
thing similar to Dreamweaver (I don’t mind paying for it, 
so it can be commercial). I need something where I can 
use graphical tools to lay out pages and style them easily. I
want to work in code view (with the HTML) only when really
necessary—for example, when writing PHP for database 
connectivity. I have tried Nvu, and I really hope that there 
is something better available out there for Linux, freeware 
or commercial. I found Nvu’s interface quirky and could not
figure out how to get it to support PHP. Surely something 
as basic as PHP should be supported by a Web editor with
the reputation of Nvu?

Maybe you can dedicate a whole issue to all the tools avail-
able and their uses in the Web-building workflow—from
graphics, layout and dynamic coding through publishing.
Seeing that the majority of Web servers run on Linux, there
must be a large amount of people in the Linux community
who design Web sites. What are they using? Thanks again
for your excellent magazine—keep it up.
—
Cobus van Zyl

It’s great that you should ask. Next month’s issue will try to
introduce a few alternative Web development products to
coincide with our Konquer the Web issue.—Ed.�
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NOVELL ANNOUNCES SUSE 
LINUX ENTERPRISE DESKTOP
http://www.novell.com/products/
desktop/preview.html

At CeBIT 2006 in Hannover, Germany,
Novell unveiled its next-generation enter-
prise Linux desktop, SUSE Linux Enterprise
Desktop (SLED). For many, SLED proves that
Novell is keeping a promise it made last
year, to invest in delivering a desktop that is
designed for the business user, rather than
for experienced Linux users. Nat Friedman,
vice president of Linux desktop engineering
for Novell, said, “When we started work on
SUSE Linux Enterprise Desktop, we didn’t
want to build the best Linux desktop for
business, we wanted to build the best
desktop for business, period. By listening to
users, we believe we have created a busi-
ness desktop that leap-frogs the market.”

Novell conducted hundreds of distinct
usability tests and shot almost 1,500 hours
of user interaction video that it used to aid
the design of SUSE Linux Enterprise
Desktop. Each feature of SUSE Linux
Enterprise Desktop, such as setting desktop
preferences, finding files, launching applica-
tions, using external devices like USB mem-
ory sticks, working with the Internet, and
connecting to local and wireless networks,
was rigorously tested and refined for usabil-

ity to ensure the best possible performance
in a business environment.

To simplify migration to Linux, SUSE Linux
Enterprise Desktop is designed to work with
Microsoft Windows, Microsoft Office and
Microsoft Exchange. The Novell edition of
OpenOffice.org, included with SLED, will
support many Visual Basic macros, closing
one of the chief compatibility gaps between

OpenOffice.org and Microsoft Office. SUSE
Linux Enterprise Desktop supports all stan-
dard network and printing protocols and
integrates seamlessly in existing Active
Directory environments, and the Novell
Evolution e-mail client includes an integrated
connector for Microsoft Exchange.

Finally, SUSE Linux Enterprise Desktop is
the first enterprise Linux desktop to include
the powerful Xgl-based graphical capabili-
ties. These capabilities take full advantage
of the 3-D accelerated hardware commonly
shipped in modern systems. With Xgl,
SUSE Linux Enterprise Desktop delivers an
industry-leading end-user experience.

TTUUXX DDeelliivveerrss  tthhee  NNeewwss
TUX introduces a breaking-news section with the SUSE Linux Enterprise Desktop
announcement and the One Laptop per Child Project. KEVIN SHOCKEY

Xgl-Based 3-D Desktop Cube

http://www.novell.com/products/desktop/preview.html
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ONE LAPTOP PER CHILD PROJECT 
WILL USE FEDORA DERIVATIVE
http://www.laptop.org

One of the underlying themes of the
recent LinuxWorld Conference and Expo
in Boston, Massachusetts, was the focus
on the One Laptop Per Child Project.
Initially started at the infamous MIT
Media Lab under the direction of Nicholas
Negroponte, the project and Negroponte
have since left the university due to sup-
port by Advanced Micro Devices (AMD),
Brightstar, Google, News Corporation,
Nortel and Red Hat.

The goal of the project is to provide
children around the world with new

opportunities to explore, experiment and
express themselves. And although the
devices will be laptops, their primary pur-
pose will be, at least initially, a more
effective way of disseminating text books,
in e-book format, and keeping those text-
books up to date.

Before you get excited about maybe
picking one up for your kids, please note
that the laptops, which are not in produc-
tion yet, will not be available for sale. The
laptops will be distributed only directly to
schools through large government initia-
tives. According to the project’s Web site,
the laptops are intended to be sold in
batches of one million. As shown here,

three prototypes currently are available.
Project leaders already have made

some key decisions. First, all of the soft-
ware for the laptop must be open source,
starting with the operating system.
Negroponte politely turned down offers
from both Steve Jobs and Bill Gates and
their companies’ respective operating sys-
tems, choosing instead to base the lap-
tops on a Fedora derivative. Next, all of
the applications also will be open source.
To project leaders, it is important that as
the children grow and pursue new ideas,
the software and tools should be able to
grow with them and provide a gateway
to other technology.�
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Dear readers: you ask many good questions. I want to answer
all your questions, but I must ask a favor. Please give me more
information. I wish I could visit your house or your company to
find out more about your computer or how you run Linux, but I
cannot do that. I cannot go anywhere because my boyfriend
Otaku has me chained to my computer chair. The chair does not
have rolling wheels, so I must stay in one spot unless I hop up
and down, and that is hard because the chair is heavy and I am
petite and frail but very beautiful. He only feeds me sushi once a
day. That is good for my figure but I am a hungry prisoner. I am
a poor tortured but beautiful woman.

Did I make you cry? Do you feel sorry for me now? Do not worry,
I am teasing you. Otaku really feeds me sushi two times a day.

I am serious that you should send me more information
when you ask questions. Sometimes I must know what distribu-
tion you are using. Sometimes I need to know if you are using
the kernel that comes with your distribution or if you made a
custom kernel. Sometimes I must know if you installed the latest
updates. Sometimes I must know what kind of PC you are
using. Maybe you can even tell me what motherboard you are
using, if you know. If you do not know, that is okay. Maybe you
are using a brand-name PC like Dell or HP. You probably will not
know what motherboard they use.

If you do not know any of this information, then just tell me
your shoe size. I do not need this information, but it would be
fun to know.

Q Dear Ms Mango: it is a pleasure to read your comments
and answers to the questions in TUX. I may not be called a

new user to computers. I’ve working with CS since 1965, and
with Linux since about 1994, but now I have hit the wall with a
small problem.

I bought an ECS Elitegroup 331 laptop without OS, intend-
ed for use solely with Linux. After trying Knoppix 4, SUSE 9.3
and 10.0, Ubuntu 5.10 and FreeBSD 6.0, I nearly gave in.
None of them could get the X server up and going. (I didn’t
try to tweak it manually.) So, I had read that SimplyMEPIS
could be a good choice for problematic hardware. I down-
loaded version 3.4.3, burned a CD and went to work.
Everything installed without problems. But, I observed that
the panel clock seemed to run in double speed. Also, logging
off seems to bring SimplyMEPIS to set the hardware clock to
the panel clock’s value.

I have searched on the Internet to see if someone else 
has had this problem and solved it. I found someone on
MepisLovers, and also some means to solve the problem.
It is no solution to correct the fast-running panel clock by
connecting to a time server, as was one person’s answer. I
have also tried to correct some minor punching errors in
/etc/init.d/hwclockfirst.sh and /etc/init.d/hwclock.sh, without
help. It looks like it might be a clock interrupt problem, but 
I don’t know.

For normal use, I prefer SUSE and KDE, but in this case,

Mango tames crazy clocks and blind mice and then goes on a power trip.
MANGO PARFAIT

Q&A with Mango Parfait
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I selected a distro based on Debian with KDE to give it a try.
I will be very happy if you can dig out a solution to the clock
problem, so I can stay with SimplyMEPIS, or else I may have to
try to get another distro up and running on the 331 to see if
the panel clock can get to normal speed. I have another laptop
running SUSE 9.3, and two other stationary PCs running SUSE
10.0 without any such problems.

Do you see any way to correct or work around the problem?
Don’t tell me that I shouldn’t have bought that box. Due to my
question, the shop tried Knoppix 4.0.2 on it and it worked,
though the WLAN wouldn’t come up (rt2560 chip). SimplyMEPIS
looks like it is happy with the hardware.

Thank you in advance! Continue your good work!—Nils

A You should not have bought that box. Please excuse me, 
I am joking with you.

You have a crazy clock in your laptop. I have a computer
with a crazy clock too. It does not run two times the right speed
but it runs very fast. I hear the American expression “time flies
when you are having fun.” Maybe our computers are having
too much fun.

Why is it no solution to connect to a time server? Do you
mean that you used the KDE clock setting dialog to set the time
automatically? That will not fix your problem. I think this sets
the clock one time. It does not check later to see if the time is
still right.

You will have the same problem if you set the date with 
ntpdate. This sets the clock only one time. It sets the clock
when you boot Linux. The clock will still run fast after that.

Try ntp-server. That is the most popular name for the pack-
age for Debian and distributions that start with Debian. You can
use your favorite package manager to install ntp-server. I think

Knoppix includes the Synaptic package manager. It will install
some other packages too. This is okay.

Here is the thing you must know. Do not be impatient.
You install the time server ntp-server on your laptop. If it
runs okay, it will set the clock. You will probably see that
your clock is still too fast because your time server does not
know that your clock is too fast. Wait. Your time server will
check a time server on the Internet later and set the clock
again. Then it will do it again. After a while your time server
will learn that your clock is too fast. It will make a setting in
a file to remember that your clock is too fast. Then it will fix
the clock speed every time you start Linux.

This does not always work. Sometimes your clock is so fast
that the time server gets angry and gives up trying to fix it. But
it is a good try.

You also can try the package adjtimex. This program does
not need an Internet connection to work. This program checks
to see whether your clock is too fast or too slow. Then it picks
some numbers to fix the clock and saves these numbers in a file.
You will see it test your clock when you install it. It is picking the
fix-it numbers. Once it picks the numbers, it uses these numbers
to adjust your clock every time you boot Linux.

The adjtimex program did not work for me. My clock was
too fast and made the adjtimex program pick settings that it
could not use when I rebooted my computer. This does not
make sense to me. If adjtimex could not use these numbers,
why did it pick them? I do not know. This was a long time ago.
Maybe the people who wrote adjtimex have fixed that problem
by now. It is worth trying if you do not have an Internet connec-
tion all the time or if ntp-server does not work for you.

It is not usually a good idea to try both ntp-server and
adjtimex. Pick one or the other.
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Q Today a friend of mine told he changed his mouse from
USB to PS/2, and now it is not working on Ubuntu 5.10. As a

Debian user, I told him to emit the command dpkg-reconfigure
xserver-xorg in order to reconfigure the mouse in the X system.
As this didn’t work, I sent him an xorg.conf set with PS/2 mouse
configured, and again the mouse didn’t wake up.

Maybe he has to create or change the /dev/input/mice,
but from now on, I can’t help him. I appreciate any help.
—George Anderson

A Your problem is very simple. You should not use a
PlayStation 2 for a mouse. That is silly.

Okay, I will give you a real answer.
I do not understand why your xorg.conf file did not work

for your friend. If your xorg.conf file was exactly the same as
his file, except for the PS/2 mouse setting, it should have
worked. Here is what you need to do. You must edit your
/etc/X11/xorg.conf file. You must do this with root privileges, so
you will need to log in as root or use the sudo command. If you
can use the sudo command, open a terminal window or log in
to a console. Then, put the name of your favorite editor in the
place of <editor> in here:

$ sudo <editor> /etc/X11/xorg.conf

If you cannot use sudo, you must log in as root first. Then
do this command:

# <editor> /etc/X11/xorg.conf

Look for this line (or something like it):

Option     "Device"        "/dev/input/mice"

Change the line to this instead:

Option     "Device"        "/dev/psaux"

Save the file. Now restart your X server. The mouse should
work. If the mouse acts funny, maybe you need to change some
of these lines too (they may not say these exact things):

Option       "Protocol" "ExplorerPS/2"
Option       "ZAxisMapping" "4 5"
Option       "Emulate3Buttons"    "true"

I cannot tell you how to change these lines, because I do
not know what kind of mouse your friend has.

Your friend may have one other problem. You must make
sure that the kernel supports a PS/2 mouse. Did your friend
compile his own kernel? He should be sure he compiled support
for PS/2 mice. If he is using a normal kernel, maybe the PS/2
mouse module is not loaded. Try this command:

$ sudo lsmod | grep psmouse

You have a problem if you look at the output and do not
see the module psmouse. You must load this module. Load
the module this way:

$ sudo modprobe psmouse

If your friend finds out that this module was not loaded, he
can make it load every time he starts Linux. Tell him to change
<editor> to his favorite editor and type this command:

$ sudo <editor> /etc/modules
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Add this line to this file:

psmouse

Save the file and exit the editor. Now Ubuntu will load
the psmouse module every time he starts Ubuntu.

Q I set up a Web server for my company’s network running
Kubuntu Breezy Badger. It seems to work flawlessly with

the exception of its nearly daily random shutdown. Usually, when
I arrive in the morning, it has shut itself down during the night.
I checked the BIOS settings for an automatic shutdown feature,
but none are checked.

My Web server last year was SUSE 8.3, and it didn’t 
display these tendencies. I don’t want to go back to SUSE,
because I like Kubuntu much better with the exception of 
the random shutdowns.

Please help me.—chaz

A This is like a joke I heard a long time ago. Maybe it is not a
joke but a real story. I do not know. Every night the clean-

ing lady unplugs the server so she can plug in the vacuum.
If I can look at your machine, I can probably tell you the prob-

lem. I cannot look at your machine. I will guess four problems then.
First, maybe your power supply is failing, and you need a

new power supply. Sometimes a stinky power supply makes
a machine shut down for no reason that you can see. I am
guessing this is the problem.

Maybe you have a bad machine. Maybe the motherboard
does not work right anymore. This is probably not the problem,
but I think it is a good idea to think about this.

Do you have an Uninterruptable Power Supply (UPS) for

this machine? Do you have it hooked up to your machine
with the serial port or USB port or something? Maybe you
also have software that listens to this port and shuts down
the machine when your UPS tells it to shut down. Maybe your
UPS is failing, or maybe the UPS software does not work
right. The easy way to see whether this is the problem is to
take away the UPS. Plug the server in to a regular power
socket. If your machine stops shutting down, you know the
problem has something to do with your UPS.

My last guess is okay, but this guess would make your
machine shut down more often than once a day. But I will
tell you anyway. Maybe the Linux kernel you use is running a
version of ACPI or APM that does not work well with your
machine. How do you turn these off? There are many ways.
There are so many ways that I do not have space to tell you all
of them. So I have to assume you are a geeky user and you can
figure out how to change the way Linux boots. Make sure
Linux boots with these two parameters: acpi=off and apm=off.
Here is an example from a GRUB menu.lst file:

kernel     /boot/vmlinuz root=/dev/hda1 acpi=off apm=off

It does not matter if your boot scripts try to start a dæmon
that uses ACPI or APM. This script will not work if you turn off
ACPI and APM. You will get an error message when the script
tries to start. Ignore that message. You can always uninstall the
dæmons later if this fixes the problem.�

I am a sweet, humble, delicate and very cute genius who is at your service to answer
your Linux questions. Send your questions to mango@tuxmagazine.com. I am deeply
sorry that I do not have time to respond to anyone directly by e-mail, but I will select
as many questions as I can and answer them here.
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TUX has given quite a focus to digital
photography, covering digikam in
September 2005 and gThumb in
October 2005. This month, we take
a close look at how to use F-Spot,
a photo management application for 
the GNOME desktop.

F-Spot provides an extremely slick
interface for organizing, editing and
sharing your digital photographs. It
supports a myriad of file types and
has excellent support for the various
RAW formats used by high-end SLR-
style cameras. Even on hardware
that is modest by today’s standards,
F-Spot performs well. It also has
support for the gphoto2 library for
interfacing with digital cameras.

When you first run F-Spot with
an empty library, you’re shown the
import dialog (Figure 1). To import
photographs, choose the location
containing your photographs and
import them via the Import Source
menu. Removable devices like
cameras, USB Flash drives and CD-
ROMs are shown in the drop-down
box, or you can choose Select
Folder and navigate to a location

on your hard disk.
By default, F-Spot copies all

imported files to a Photos folder in
your home directory. You may want
to untick the box Copy file to the
Photos folder if you are accessing a
photograph library over a network
share and you’d rather not copy
them locally.

F-Spot makes use of tagging
and a timeline to help organize your
photo library. You can assign multiple
tags to each photograph. Categories
and tags are similar except categories
can have sub-tags.

You can tag photographs in a
few different ways. To tag by drag
and drop, select a photograph or a
group of photographs and drop
them onto the tag in the sidebar.
You also can reverse this by dragging
and dropping a tag onto the photo-
graph. Both methods work if you
have selected multiple photographs.

You also can right-click on a
photograph or a selected group of
photographs and select tags from
the context menu. The Tags menu of
the main application window modifies

tags for the selected photograph or
group of photographs.

Finally, my favorite method and
the most convenient one for mass

tagging is to tag as you type.
Pressing T while a photo or group of
photos are selected allows you to
type tags into the pop-up box to be

FF--SSppoott
A personal photo management application for the GNOME desktop that could be
the best program of its kind for any platform, but it’s available only for Linux.

JES HALL
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applied en masse. You can specify
multiple tags by separating them
with a comma. If you type in tags
that don’t exist, F-Spot creates them.

BASIC EDITING TASKS
F-Spot lets you perform basic editing
tasks within the application without
using an external editor. To enter the
Edit Photo view, double-click on an
image thumbnail or click the Edit
Photo button in the toolbar with a
photograph selected. F-Spot always
preserves your original image, and all
modifications are made on a copy.

The photograph shown in Figure
3 was taken through tinted windows
in an office building, so it has turned
out very drab. It can be improved by

increasing the contrast and satura-
tion a bit. To correct colour on an
image, either click the small icon
with three circles below the image in
the Edit Photo view, or select Adjust
Color... from the Edit menu.

In Figure 4, I’m increasing the
exposure, saturation and contrast to
brighten up the image until the
colours look as natural as I can get
them. The image is still a little unreal
looking, but it is a vast improvement
over the dull original.

If you don’t like your changes,
you always can delete the modified
version and revert to the original.
Make sure Modified is selected in the
Version box underneath the filename
to the left. Select File→Delete Version

to delete the modified image.
F-Spot includes tools to apply

black and white or sepia tones to a
photograph. These buttons are the
last two located on the toolbar below
the image. There is also a simple red-
eye removal tool. To use it, zoom
right in on one of the affected eyes,
and select the red area as precisely as
you can. Then, click the small icon of
an eye on the toolbar below the
image. Repeat with the other eye.

One of the most common adjust-
ments I make to images is cropping,
either to center the object I want to
focus on or to remove unwanted
elements. F-Spot’s crop tool is simple
to use (Figure 5). Drag a selection
over the part of the image you want

HOME PLATE
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Figure 2. Tagging with F-Spot Figure 3. A Photograph Taken
through Tinted Windows

Figure 4. The Same Photograph with the Colours
Corrected

Figure 5. Cropping can recentre the
focus of a photograph or remove
unwanted background elements.
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to keep, and then click the small
icon that looks like a penknife
below the image. If you want to
limit the selection to a certain aspect
ratio, the drop-down box to the left
of the crop icon contains a list of
common ratios.

PHOTO SHARING
F-Spot makes sharing your photo-
graphs easy by exporting to popular
Web gallery software and creating
standalone galleries on disk or 
CD-ROM/DVD.

Flickr (http://www.flickr.com) is
an on-line photo management and
sharing application. It’s a lot of fun,
with great tools for managing your
photographs and creating a network
of friends with similar interests or
location. Note: to export to Flickr,
you need to have a Flickr account.

Select the photographs you’d like
to export to Flickr, and then select
Export→Export To Flickr from the File
menu. In the dialog that appears,
click Authorize. F-Spot launches your
default browser and navigates to a
Flickr page where you can give F-Spot
permission to read and write to your
Flickr account. Click the large blue
button labeled Ok, I’ll Allow This.

Once you’ve done that, return to
the F-Spot application, and click
Complete Authorization. Now F-Spot
should send your selected photo-
graphs to Flickr when you click OK.
Once these images have finished

uploading, your browser is launched
again. Navigate to a Flickr page
where you can add titles and com-
ments to your images.

Flickr also uses a tag system,
and you can export your images
with the tags intact by ticking the
box Export Tags.

F-Spot also includes a tool for cre-
ating simple standalone Web gal-
leries. Select the images for which
you would like to create a gallery,
and then chose Export to Folder
from the File menu. Type in a name
for your gallery beside Gallery Name
and select Create standalone Web
gallery under Export Method.

Once you’ve finished with this
dialog, click OK. Your gallery is creat-
ed and saved to the desktop. To
view it, load the index.html file from
the folder Gallery on your desktop in
a Web browser. The gallery is simple
but visually striking.

Being able to back up my photo-
graph collection to CD and DVD is
important to me. Those photographs
are a record of many significant
events in my life and the lives of
loved ones, and losing them in a
hard drive crash would be painful.
F-Spot provides a tool for exporting
photographs to CD. To use it, select
the photographs you want to back
up, and then choose Export→Export
to CD from the File menu. A dialog
appears showing you thumbnails of
the photographs you’ve chosen.

Click OK to confirm, and F-Spot
copies the photographs to a 
temporary location and then 
displays the Write to Disc dialog.
Click the Write button to start
burning the CD. Once the burning
process has finished, a dialog asks
if you’d like to eject the disk and
either make another copy or close
the burning tool.

F-Spot is an excellent tool for
managing photographs and is the
best program of its kind I’ve used on
Linux, Microsoft Windows or Apple’s
OS X. There is simply no competition
for me as far as ease of use and
features goes.

Although we’ve looked at quite
a few ways to organise and share
photographs with F-Spot, this article
by no means covers all of F-Spot’s
features. To learn more about it, take
a look at the F-Spot User Guide at
http://f-spot.org/User_Guide.�

Jes Hall is a UNIX systems
consultant and KDE
developer from New
Zealand. She’s passionate
about helping open-
source software bring
life-changing information

and tools to those who would otherwise
not have them.
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Figure 6. The Export to Folder tool includes the option to create striking galleries.
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This month’s look at business applications is a
great time to see how small-office/home-office
(SOHO) operators can use native Linux accounting
software to run their businesses. SOHOs are a
powerful group, encompassing part-time busi-
nesses as well as advanced entrepreneurs. Last
month, Novell conducted a survey about which
applications people most want ported to Linux.
Guess what? Quickbooks was the top pick in one
of their recently announced results.

Not surprising, Quickbooks arguably holds the
top spot in small-business accounting software with
many loyal followers. For SOHOs, being able to stay
on top of finances is critical. Without a large staff
of accountants, SOHOs usually must balance and
manage the books themselves. Most of the ones I
know have almost no interest in accounting soft-
ware unless it’s time to make a deposit. So the real
unsavory tasks, like figuring taxes and paying bills,
need to be quick and easy to complete.

It’s a sure thing that most SOHOs would rather
spend a lot more time making money instead of
tinkering with financial packages. To survive, how-
ever, all small businesses have to watch profit
margins. One strategy to help is to keep software
costs low, so using a Linux operating system with
OpenOffice.org fits the budget well. Finding a
substitute for Quickbooks is more challenging.

Adopting new financial software can be painful

when you’re already comfortable with Quickbooks.
After all, you could have years of data on file, your
accountant already may be prepared to receive
Quickbooks data and no one wants to spend a lot
of time learning new software.

If you already have Quickbooks, you could install
it on Linux with Wine or CodeWeavers. Or, you
could shell out a little more cash and put VMware
on your PC to take legacy Microsoft products with
you. Of course, this works, but you’re still
spending hard-earned money on
CodeWeavers or VMware. Plus, the cost of
Quickbooks upgrades, annual tax tables and
monthly payroll processing may be more
than you want to spend on accounting.

Without question, a big market exists
for Linux SOHO financial software, but
choices are limited with no clear market
leader. Good Linux applications do exist
for personal finance. Some, like
GnuCash, even handle receivables and
payables, but a business needs a total
accounting package with some value-
added benefits. Appgen’s MyBooks
Professional can be a fit for SOHOs and
expanding companies alike. MyBooks
Professional offers a solid feature set for
business users looking for a commercially
backed accounting package.

IMPORTING QUICKBOOKS DATA
A primary concern for SOHOs is how to get up
and running quickly on any new software.
Surprisingly, MyBooks can import your Quickbooks
data. Signing up for trial software allows you to
download both Windows and Linux versions of
the software. MyBooks for Windows converts the
Quickbooks .qbb file and produces a compressed
.agz file. MyBooks for Linux imports the .agz file
containing your old Quickbooks data.

Appgen’s documentation is clear, and the one-
click import utility is extremely user-friendly. If you
decide not to import old data, there are detailed
instructions to create start-up entries for impor-
tant bookkeeping accounts. Overall, the import
and setup is not complicated, and SOHOs can
start using the software immediately.

MMaannaaggiinngg  SSOOHHOO  BBuussiinneesssseess  wwiitthh
AAppppggeenn  MMyyBBooookkss  PPrrooffeessssiioonnaall
A look at MyBooks Professional from a Quickbooks’ perspective—are the benefits significant enough?
DONALD EMMACK
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LEARNING MYBOOKS
Most people prefer to skim read the Quick Start
Guide, but unless you are an accounting wizard,
you should learn how to prepare MyBooks for your
company’s needs. After data conversion, MyBooks
presents you with a few short pages of valuable
documentation about pre-loading inventory data,
tax setup and making the first ledger transactions.
Knowing these basics makes the accounting expe-
rience much simpler. If you have time, several
other detailed manuals are available in the system
documentation to lead you through other features
like batch entry, vouchers and inventory.

GETTING ACQUAINTED WITH DOUBLE ENTRY
MyBooks differs a bit from Quickbooks in opera-
tion, because it conforms to strict double-entry
accounting rules. As the name implies, double
entry requires a two-step process for financial trans-
actions. First, MyBooks holds any new transactions
in a temporary location for final review. Once
approved, the transactions are posted and perma-
nently stored. This means you cannot delete posted

transactions; adjustments must be
made with journal entries or other
proper accounting means.

Many former Quickbooks users
shudder and proclaim double entry
as redundant and restrictive. It is,
and Appgen’s documentation cites
security and conformity to general-
ly accepted accounting principles
(GAAPs) as reasons the software is
designed this way. That said, it’s
really not difficult to grasp, and
after a few transactions, double
entry almost feels comfortable.
MyBooks obtains information
sequentially, so it’s best to restruc-
ture your workflow to match the
system. Perhaps it is double-entry
accounting, or the design of
MyBooks, but I was able to lessen
my time with data entry and spend
more time looking at the financial
picture of the business.

CLASSIC ACCOUNTING
Prepare yourself, the look of
MyBook’s home screen is spartan
compared with Quickbook’s home
screen. However, judging system
ability by first glance can be a mis-
take. Appgen condensed the
number of choices into a simple
menu for navigation. More com-
plex transactions are found under
the Accountants menu, leaving
the core features up front. Other
reports and features interesting to
SOHO operators are readily avail-

SUITED UP
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Figure 2. Posting Journal Entries Menu

Figure 3. Accountants Main Page

Figure 4. Sales and Customers Tab
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able in a package called Executive Dashboard, which
I discuss later.

At first use, you will recognize the design of
MyBooks corresponds to the work sequence of a
SOHO. So, menus differ between service- and
product-based businesses, and you can freely
switch between the two at any time.

The MyBooks login brings up a home screen
that serves as a base camp for most operations,
and Appgen divides MyBooks into four areas:
Sales and Customers, Vendors and Purchases,
Payroll and Banking Accounts.

SALES AND ACCOUNTS PAYABLE
Start-up instructions prepare the system so new users
immediately can begin regular tasks like invoicing and
paying bills. For each task, flowchart-like menus lead
you through the necessary steps to create, check and
finally post invoices and bills. Although no electronic
interface exists for bill payment, you can print invoices
and checks on prefabricated forms available from
your local office supply store.

PAYROLL AND BANKING
Employee payroll should be a concern for any

small business. Even for a few employees, paying
a service provider to calculate payroll is costly.
So, to reduce overhead expenses, it’s possible to
produce payroll yourself.

MyBooks initializes your beginning payroll infor-
mation so you can start using the system rapidly.
The software also handles state tax withholding and
other deductions important for employees. These
tables expire regularly, but MyBooks Professional
provides annual free tax tables for users.

Currently, you must handle banking tasks the
old-fashioned way by reconciling your accounts

SUITED UP
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http://www.tuxmagazine.com


with monthly statements sent to you from your
financial institution. This is a big drawback for any
business with lots of ad hoc electronic transac-
tions. There is also no way of importing a .csv or
other check register data.

COOL CLIENT/SERVER OPTIONS AND ODBC
Former Quickbooks users are familiar with sending
their accountant a snapshot of their data, called
an Accountants Copy. The accountant then makes
necessary financial manipulations and returns the
file for integration with the original data.
MyBooks works differently via a client/server
arrangement. When you set up a server version of
MyBooks, your accountant can use a client appli-
cation to access your data.

MyBooks also provides detailed instructions on
setting up your own database to tinker with
financial information captured by MyBooks. Many
SOHOs may not need to use this feature; howev-
er, it is helpful when you want to extract data for
analysis. It’s also useful if you ever need to send
data to another system. I’ve been in this position
during a merger, and SQL would have been much
simpler than passing a hard copy of the general
ledger around for review.

EXECUTIVE DASHBOARD
Just like it sounds, Executive Dashboard allows the
SOHO executive to display a snapshot of the com-
pany books. This dashboard has many “bottom-
line” numbers I’ve found helpful in measuring my
own business’ performance. With Executive
Dashboard, users get up-to-the-minute informa-
tion about corporate financial health. Although it
can be purchased separately, Executive Dashboard

is included when you buy MyBooks Professional.
Like Quickbooks, MyBooks provides “drill

down” on many pre-made and custom reports.
This kind of analysis is handled through MyBook’s
Information Central menu. Here, SOHOs can

inquire and mine information on most transac-
tions in the program.

CAN-DO WITH MYBOOKS?
For non-accountants like me, bookkeeping is a
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painful chore. Add to that, Quickbooks’ very
mature feature list and the years of experience
you might have using it to run your business, and
the idea of abandoning it seems unrealistic. To
make the idea of replacing a familiar package like
Quickbooks with something else, there must be
significant benefits of using MyBooks. Here’s my

list of the top SOHO benefits:

1. Price: MyBooks Professional for Linux currently
sells for around $60 US, substantially less than
Quickbooks.

2. Executive Dashboard: a real benefit, simply out-

lining some important management data for
daily review in a user-friendly format.

3. Client server/ODBC: just like the competition,
MyBooks can get your small business going
now and handle more complex activities when
it grows larger.

4. Structured Data Entry: double-entry accounting
and MyBook’s design draws your attention to a
formal bookkeeping approach.

5. Commercial support: open source is a great
mechanism, but having a corporate sponsor can
put you at ease if trouble arises. Appgen’s mar-
keting information touts an estimated 10,000
users of its Linux product—looks like a fast
growing user group.

From my viewpoint, MyBooks hits these spot
on. Critics still might claim Quickbooks as the
small business industry standard. That’s true—for
now. Last year, Microsoft launched its small-office
financial software to compete directly with
Quickbooks. We’ll just have to see how the mar-
ketplace responds to each product. Meanwhile,
Appgen’s MyBooks can give SOHOs a full-featured
accounting package that will support a small busi-
ness now and a growing business later.�

Donald Emmack is Managing Partner of
The IntelliGents & Co. He works exten-
sively as a writer and business consultant
in North America. You can reach him
at donald@theintelligents.com or by
cruising the 2 meter amateur RF bands
in the Midwest.
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Project planning tools provide a way to
keep track of tasks and resources associ-
ated with a project and see how these
resources can be allocated for timely 
and efficient completion of goals. What
project management tools are available
for Linux, you ask, and how do they
shape up? Let’s take a look at Imendio
Planner and TaskJuggler—two very popular
project planning tools.

IMENDIO PLANNER
Imendio Planner (http://developer.imendio.com/
wiki/planner) is a project planning tool for
the GNOME desktop environment. It lets
you define tasks and subtasks, resources
and resource groups. It can track dependen-
cies between tasks and maintain both
individual and project calendars. The latest
version includes a simple importer for the
XML exchange format used by Microsoft
Project 2002 and later.

Planner’s interface is divided into four
views: Gantt Chart, Tasks, Resources and
Resource Usage. The Gantt Chart view is
task-focused and shows the tasks that
make up the project, who has to complete
them and under what time constraints. The

IImmeennddiioo  PPllaannnneerr  aanndd  TTaasskkJJuugggglleerr::  aann  OOvveerrvviieeww
Project planning software can be an essential asset to any office; TUX introduces two leading tools.

JES HALL

Figure 1. Imendio Planner Showing the Gantt Chart View
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Gantt Chart view is where you build up your
project plan from items added in the Task and
Resources views, by adding and linking tasks and
setting time constraints.

The Tasks view provides a table-style view of
the tasks that make up a project. The Tasks view
allows you to edit more properties when adding
a task than the Gantt view does, and so it should
be used to add tasks to a project initially.

The Resources view lists resources by name.
Resources can include people available to work on
the project, buildings or rooms available for use or
other equipment required for the project to be
completed. Once you have added resources to this
view, you can assign them to tasks shown in the
Gantt Chart view.

The Resource Usage view displays a sample
chart showing how resources are used over time.

Planner concentrates on the use of the graphi-
cal interface to create project plans, making it eas-
ier to get started for some, as compared with
TaskJuggler.

Planner has the ability to use an external
database for storing project plans. The only data-
base supported is PostgresSQL, and the support
is very rudimentary. The Planner User Guide
shows how to set up using an external database.

Planner can export an HTML page of a proj-
ect. The exported page contains a simplified
Gantt Chart, task list and a resource allocation
table. Planner’s Microsoft Project XML importer
is extremely limited, and it is unable to import
calendars, project properties or resource groups.

Calendars in Planner are simple but flexible,
and let you define working and non-working
days for resources, as well as which hours
within those days are working hours. Each
resource can have its own calendar or use the
project default calendar. Changes made to cal-
endars are reflected automatically in the Gantt
Chart view.

Planner’s documentation is fairly basic, cov-
ering only the most rudimentary details about
how to create project plans. Imendio provides a
low-volume user mailing list that is monitored
by the developers for support for Planner.

TASKJUGGLER
TaskJuggler (http://www.taskjuggler.org) is a proj-
ect planning tool sponsored by SUSE. It uses the
Qt toolkit and requires KDE libraries, version 3.4
or greater are recommended. It integrates into a
KDE desktop environment.

TaskJuggler projects are created by detailing
what is known about a project in a text file.
The syntax TaskJuggler uses is relatively easy to
learn but may turn off those who prefer a
WYSIWYG approach. The defined elements
cascade, and each sub-element inherits the
properties of the previous element, which
makes defining elements very efficient.

Flags are used to filter properties to fine-
tune reports. Once defined, a flag can be
attached to many different properties and can
be used to limit reports to exactly those details
you want to include.

TaskJuggler lets you define calendars with flexi-
ble working hours and supports specific vacations
for individual resources. Calendars also support
shift work and multiple time zones. Multiple proj-
ect scenarios are also available, so one can define
the original project plan, as well as a alternate
scenarios that take delays or changes in resources
into account.

You can manage costs by creating accounts.
Resources can have running costs assigned to
them, and accounts can be created to keep track
of costs and customer payments for simple profit
and loss analysis. Tasks may have initial, finishing
and running costs defined that also affect the
profit and loss statement.

Once a project is defined, you can use the
TaskJuggler GUI to view and modify interactive
reports. HTML export allows you to create a
variety of reports from detailed calendars to
Gantt and PERT charts. Groupware support is
implemented in the form of using a revision
control system like CVS on the project descrip-
tion files, and you can use a central database
for resource allocation.

TaskJuggler’s documentation is exhaustive
and excellent, with a full reference of elements
used in the text project definition files.
Workshops and training in TaskJuggler are
available from the project, and a forum is
maintained for user support.

TaskJuggler is extremely flexible and powerful;
it is suitable for use on large and complex proj-
ects. The syntax for the project file is somewhat
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esoteric, and those looking for a simple
tool to track a small project may find
working with TaskJuggler overwhelming.

Although Imendio Planner has some
glaring deficiencies when compared to

TaskJuggler, it’s clear that neither program
is done any favors by a direct comparison.
Each program fills a particular niche for a
different target audience. Imendio Planner
excels at allowing you to create simple

project plans for small projects quickly.
TaskJuggler, on the other hand, is a pro-
fessional and powerful tool suitable for
the most complex project—but with a
steep learning curve.�
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Figure 2. TaskJuggler Showing an Interactive Report
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As a newbie Linux user, it seems natural to explore all the great projects you
can undertake with free software. One way to show off open source is to
use the Scribus desktop publishing (DTP) application. Scribus has evolved into
a user-friendly DTP program that captivates attention for home and business
use. It’s also just plain fun to create a slick-looking newsletter to show what
open source can do and subversively allure potential Windows converts to
the Linux operating system.

So, to further the awareness and market share of open source, I put
together these high-level instructions about the basics of newsletter creation
in Scribus. For this mini-tutorial, I used Scribus 1.3.3, which is a developmen-
tal version. The change log of version 1.3 notes some significant differences
from previous releases. The most important one may be that file format
changes make 1.3 incompatible with 1.2. To keep your data in the proper
version, you might need to save any work as Scribus 1.2 file.

GETTING STARTED
The on-line documentation for Scribus includes installation instructions for six
Linux distributions, Mac OS X and Windows. Because I used Ubuntu Breezy
5.10 for this article, the base repositories did not include the development
release of Scribus 1.3.3. For Synaptic to find Scribus 1.3.3, you must add the
following repositories into your /etc/apt/sources.list:

# Ubuntu breezy
deb         http://debian.scribus.net/debian/ breezy main restricted
deb-src     http://debian.scribus.net/debian/ breezy main restricted

deb         http://debian.tagancha.org/debian/ breezy main restricted
deb-src     http://debian.tagancha.org/debian/ breezy main restricted

This is a simple procedure, and complete instructions are on-line at
http://docs.scribus.net/index.php?lang=en&page=install-dpkg. Once you have
Scribus on your PC, it’s also a good idea to get some templates to use as a
starting point for your own projects. You can download a full set of user
templates from http://www.scribus.net. The templates I installed came
from the scribus-temp-all-1.2.1.tar.bz2 file. Read the instructions within
the compressed file to learn how to install the templates.

AAtt  55,,000000  FFeeeett::  UUssiinngg  SSccrriibbuuss  ttoo  PPuubblliisshh  aa  NNeewwsslleetttteerr
How to approach desktop publishing with confidence using Scribus.

DONALD EMMACK
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THE QUICK START TUTORIAL
Scribus is not a word processor. I think it looks like
a merger between The GIMP, OpenOffice.org and
Dia. If you’re familiar with these applications, the
learning curve is minimal. Although, it’s prudent
to understand the depth of Scribus’ features to
ensure your output looks the best. I suggest that
you go through the on-line tutorial, which leads
you through creating a fancy (and rather racy)
brochure in less than 30 minutes. Following the
on-line tutorial will give new users a better under-
standing of the tools included with the program.
It also introduces Little CMS. Little CMS is a color
management system (CMS) to help you match
screen colors to those that are in the finished pub-
lication (Figure 2). You can go to the Little CMS
Web site for more information on how to use it
correctly (http://www.littlecms.com).

YOUR FIRST NEWSLETTER
After installing Scribus and the template package,
you’re ready to begin. Start by loading one of
the newsletter templates (Figure 3). For this
overview, I chose to spin my newsletter from the
Newsletter_1 template. After loading, you should
have a four-page template on-screen that looks
like Figure 4.

From here, take control of your project by
manipulating layers, frames, text and adding
colorful vector shapes. Just like other graphic pro-
grams, Scribus uses layers of objects to help order
your work. You can place frames (boxes) almost
anywhere and define them as text, images, tables,

shapes and lines.
Scribus’ on-line documentation

suggests using pencil and paper to
create a first draft of your DTP layout.
This can be a real time saver for some
projects. As we’re working with an
existing template, I have only a few
variations in mind to tailor it for my
needs. Because the principles are
similar for each page, let’s just look
at changing the first page of this
sample newsletter.

LAYERS
Using the layers feature is just like
using layers in The GIMP. Activate
the layer control box by pressing F6
or by selecting Tools→Layers from the
menu. The control box for layers
gives you the choice of viewing the
layer, locking it and including it in the
output. With the control box, you can
change your newsletter layout, add a
background image or remove unnec-
essary layers (Figure 5).

For this overview, I added a verti-
cal color bar to a new layer, shaded it
to match the theme and used the
layer tool to move it to the back-
ground of the graphic (Figure 6). You
also could add images, text or other
shapes defined in other programs or
created with the Scribus tools.
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Figure 2. The Little CMS Color Management System

Figure 4. The Newly Created Scribus Document Based on
Template Newsletter_1

Figure 3. Creating a New Scribus Document from a Template
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Scribus has several vector-based tools that let
you create and change shapes at will. At the top
of the screen, you should see several shape sam-
ples, which are used to place objects on the active
layer (Figure 7). Once placed on a layer, you can
adjust their shape, color, opacity and so on.

FRAMES
Frames are the primary underpinning of
Scribus. With frames, you can add text, images

or other shapes into your project.
Add frames through the Insert tab
or by typing the matching letter: 
T for a text frame, P for a polygon
and so forth. Right-clicking on the
selected frame brings up the
Properties dialog (Figure 8). This
tool lets you select
items and work with
the various features of
the selected item.

The Properties box
for text, images and
shapes each contain the
same functions and lay-
out. Moving through
the tabs (such as Color,
Line and Text) gives you
control over the item’s
appearance and size.
Once your frame layout
is complete, you can
lock the frame locations
to prevent accidental
movement and settle
in to writing the copy
for the document. I’ll

mention a tip for frame manipulation later.
If you created the text in another program

or text editor, it’s easy to cut and paste the
information. Another method is to use the
internal Scribus Story Board. With Story Board,
you add and change the text of the sample
newsletter to something more suitable (Figure
9). Long articles or stories are not a problem,
because Scribus automatically joins frames on
different pages to make text flow smoothly. So
all you need to do is focus on what you want
to say in the Story Board editor, and let Scribus
work with the layout. Scribus also gives you
the alternative of inserting faux text so you get
a better feel of the overall layout. In this exam-
ple, I selected a text box and inserted the
default “lorum ipsum” characters.

TUX EXPLAINS

34www.tuxmagazine.com

Figure 6. A Newly Created Document Layer

Figure 7. Drawing Tools and Shapes Toolbar Figure 8. Frame Properties Dialog

Figure 5. The Scribus Layout Options Dialog
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PUBLICATION AND PRINTING
After you finish placing graphics and typing text,
it’s time to see the output. DTP is a bit different
from on-line publishing. Image density and resolu-
tion have to be superior in printed form to get
really professional results. Thus, Scribus can han-
dle image output up to 4,000 dpi.

Nowadays, you can export your data on-line to
most print shops. Scribus simplifies this process
and uses the PreFlight Verifier to catch trouble-
some issues with your output before final printing.
It catches transparency conversion problems, out
of boundary errors, missing image files and similar
items rather well. To repair a flagged item, click
on the reported error and Scribus takes you directly
to the problem (Figure 10).

HANDY TRICKS
Scribus documentation implies there is a learning
curve associated with the application. As the features
and functions are similar to The GIMP, I’m never
hopelessly lost trying to understand the software. It’s

easy to
understand
the intuitive
menu
descriptions,
and the
Properties
dialog has
buttons for
many frame
manipulations. Overall, the interface is user-friendly
and the documentation answered all my questions.

For added benefit, the Scribus Web site 
has posted “Top Ten Hints: Tips and Tricks 
to make better documents faster in Scribus”
(http://docs.scribus.net/index.php?lang=en&page=topten).

I think the most useful tip is to use your mouse
wheel as a tool to spin through selections on the
screen. This gives you faster and greater control
over the selected item. Another handy trick is learn-
ing how to make a backup of your Scribus user
preferences in a hidden directory—just in case.

CONCLUSION
Using Scribus to pro-
duce a newsletter is a
straightforward task.
After speaking with
my commercial print
shop, they were
knowledgeable and
helpful for picking just
the right output
options (for example
PDF 1.4, resolution).

Most of us are not
graphic artists, but
Scribus contains the
fundamental tools
required to make your
product look good. A
short empirical survey of
my IT friends suggests
that nongraphic people
avoid DTP work because
it appears complicated.

I still am amazed at
what real professional
graphic artists produce.

For the rest of us, we can pick a few pre-made
graphics and cobble them together for decent
output. That said, I think you can approach
Scribus confidently, knowing you’ll get good
results without wasting your time.�

Donald Emmack is Managing Partner of
The IntelliGents & Co. He works exten-
sively as a writer and business consult-
ant in North America. You can reach
him at donald@theintelligents.com or
by cruising the 2 meter amateur RF
bands in the Midwest.
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Figure 9. Text Frame Story Board Editor

Figure 10. PreFlight Verifier Flags an Issue
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FreeMind is a mind mapping application. If you don’t
know what a mind map is, think of it as an outlining
program on steroids. Its task is to help map out your
ideas and thoughts on any given subject.

FreeMind is a Java program, so in order to use
it, you need to have the Java Runtime Engine
installed. Check your distribution’s documentation
and package repositories to see if there is a pre-
packaged version for your specific distribution or,
barring that, instructions on how best to install it.
If you cannot find instructions or a package for your
distribution, go to http://java.com/java/download
for packages and instructions that work for many
Linux distributions.

To get the FreeMind program, check your distri-
bution repositories or go to http://freemind.sf.net,
scroll down to the Download section and down-
load the max version for any operating system. The
current version at the time of this writing is 0.8.0,
and the file is named freemind-bin-max-0_8_0.zip.

Once you have downloaded the file, create
a folder called freemind, and put the zip file in
it. Navigate into that folder and unzip the file
using your favorite archive manager. There is
only one more thing to do to get Freemind
running. One of the files you just unzipped is
called freemind.sh. This is the file we will use
to launch the FreeMind program, but it is not

set up to be executable by default. Right-click
on this file and choose Properties. Go to the
Permissions tab. If you are using KDE, tick the
is executable check box, and then click OK. If
you are using GNOME, tick the Execute check
boxes, and then click Close.

Now you should be able to click or double-click
(depending on your settings) on the freemind.sh
file to start the FreeMind program. You may get a

dialog box asking if you want to run or view the
file; click run, and FreeMind should launch.

USING FREEMIND
The first time you launch FreeMind, you will get a
mostly blank canvas with an oval in the center
with the words New Mindmap in it. To start creat-
ing your first mind map, simply start typing. For
example, let’s say I needed to write a paper about
games. I would type the word Games and press
Enter. Now I have a root node to which I can
attach sub-nodes containing all of my thoughts on
the subject of games.

In FreeMind, everything is a node, and every
node, except for the the root node (the Games
node, in our example), has a parent. All nodes,
except for the root node, also may have sib-
lings, and all nodes may have children nodes.
To illustrate this, let’s add some children to our
Games node.

To add a new child node, press the Insert key,
fill in the box that appears, and press Enter to stop

FFrreeeeMMiinndd
Use the sophisticated FreeMind to visualize, classi-
fy, structure and generate ideas, and also as an aid
in problem solving and decision making.

DANIEL BARTHOLOMEW

Figure 1. Editing the Permissions of the 
freemind.sh File

Figure 2. The FreeMind Splash Screen
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editing. For my paper on Games, I want to write
about game history and the types of games people
play, so I press the Insert key, type the word
History, then press Enter. Now I have my History
node. The Types of Games node is a sibling to the
History node. To create a sibling, make sure that
the History node is selected, and press Enter. I then
type Types of Games and press Enter again.

If you’ve been following along, your mind map
should look like Figure 4. Let’s expand the Types
of Games node a bit by giving this node some
children and grandchildren until it looks some-
thing like Figure 5.

We’re off to a pretty good start, and I

already can see several areas that could use
some improvement. I’ve focused so much on
game types that I’ve completely neglected to

do anything with game history. In fact, it has
been bumped off the viewable area. Let’s move
it over to the other side of the root node. To
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Figure 3. A New Mind Map, Ready for Input

Figure 4. A Simple Example

Figure 5. Our Simple Example, Expanded
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do this, simply click and drag it with your
mouse to the left side of the root node. The
left side of the root node will highlight to show
you where the node you are dragging will end
up. Release the mouse, and the History node
will be moved. Let’s also take the opportunity
to add some child nodes to the History node
until it looks like Figure 6.

FOLDING AND INDICATING RELATIONSHIPS
Now we have too many items to show all of them
at the same time. FreeMind lets you manage this
through folding. Think of it as hiding the stuff you
don’t want to work on. To fold items, select the
parent of the group of siblings you want to hide,
and press the spacebar. For example, select the
History node, press the spacebar, and every node
below it becomes hidden. FreeMind puts a little
circle at the end of the line to let you know if
there are hidden child nodes.

Several items could be moved around, and
some items, although related, are clearly in dif-
ferent categories. Take card games for instance.
You can play Solitaire (or any of the other card
games) with the appropriate deck of cards or
on your computer. I don’t necessarily want to
lump all card games (whether played with real
or virtual cards) together, because I want to
have a section of my paper devoted to computer
games, but I do want to indicate their relation-
ship as part of the brainstorming process so
that I keep their relationship in mind. To do
this, I select the Card Games node and drag it
to the Card node under Computer Games while
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Figure 6. Our Not So Simple Example, Ready for Folding
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holding the Ctrl and Shift keys.
After linking a few more nodes and doing

more folding, I end up with what you see in
Figure 7.

EXTERNAL LINKS
As part of my research into this paper, let’s say I
want to go into the rules of some games. To do
this, I would most likely go to Google or another

search engine and do a search for “rules of
chess” as an example. Such a search brings up
several good resources. I could bookmark them in
my Web browser, but the point of making this
mind map is to collect everything in one place. To
that end, FreeMind lets you place links to Web
sites and local files into your mind map.

To make a link, I first copy the address of the
Web site I want to link to, and then I select the
node I want to be the link and click on the Insert
menu and then Hyperlink (Text Field). Then, I
paste the address into the dialog box that appears
and press OK. As you can see from Figure 8, there
is now a little red arrow signifying that that node
is a link. FreeMind allows only one link per node,
so if you have several links that relate to a single
node, make them child nodes.

FINDING WHAT YOU WROTE
A problem you may run into with a very large
map is finding the single node with the informa-
tion you need. An example of this is the FreeMind
documentation, which is implemented as a single
large mind map. One way to locate nodes is with
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Figure 7. Our Mind Map Folded with Some Relationships Indicated

Figure 8. A Link to a Web Site
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the Find feature, accessible from the Edit menu or
by pressing Ctrl-F.

Search in FreeMind works a bit differently than
in other applications. Instead of searching the
entire map, it searches only the selected node and
that node’s children. Although this is a handy way
of limiting the scope of the search, it also can be
annoying. An easy way around this is to press the
Esc key before you start the search. The Esc key is
a shortcut to the root node, and by going there
before you start the search, you will be sure to
search your entire mind map.

Another way FreeMind helps you find nodes
quickly is through icons. Icons can be assigned to
any node, and any node can have as many icons
as you want. The icons you can use appear along
the left edge of the FreeMind window. To apply
an icon, select a node and then click on the icon
you want to give it. To remove an icon, select a
node, and then click on the X or trash can icons
(the first two icons in the icon list). These two

icons delete the last icon applied and all icons
applied to that node, respectively. See Figure 9 for
how the icons look when applied.

SHARING YOUR MIND MAPS
You may reach a point where you want to share
your mind map with others. The best way to do
this is to have people download a copy of
FreeMind for themselves. Then, all you have to do
is send them your file. However, this may not be
practical in all cases.

Barring sending them your actual FreeMind
file, the easiest way to share your map with some-
one is to use FreeMind’s export feature. Several
export options are available, all through the
File→Export menu. The PNG and JPEG image

options are pretty self-explanatory; they create a
picture of the current state of your mind map—
folds, icons, currently selected item and so on. The
PDF and SVG options do much the same thing,
only the output will be better for printing than
with the other image formats. All of these are
static snapshots of your mind map.

A more interactive way to share your map is to
use the HTML or XHTML export options. The HTML
option does not include any graphics, so every-
thing is contained in a single HTML file. If you
want to include your icons and other graphics, use
one of the XHTML export options. All of them use
JavaScript that enables you to fold and unfold
nodes with the default folding being whatever
state your mind map was in when you exported it.
Figure 10 shows what it looks like.

CONCLUSION
FreeMind is a great way to organize your next
project or paper, and you don’t have to limit it to
those uses. FreeMind also works well for address
books, collections, bookmarks and recipes. And
with all of the talk about parents, children and
siblings—FreeMind also works quite well for
creating genealogical pedigree charts.

Give it a try. I think you’ll like it.�

Daniel Bartholomew has been using
computers since the early 1980s when
his parents brought home an Apple
IIe. After stints on Mac and Windows
machines, he discovered Linux in 1996
and has been using various distribu-
tions ever since. He lives with his wife

and children in North Carolina.

TUX EXPLAINS

40www.tuxmagazine.com

Figure 9. Icons Applied to Various Nodes

Figure 10. An XHTML Export Example
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With all the excitement surrounding Skype, it’s
easy to forget that there are other Voice over IP
(VoIP) service providers out there. One such
provider is Wengo, which offers WengoPhone
software as well as the VoIP service. Although
WengoPhone doesn’t have the same mind share
as Skype, it does offer something more valuable—
namely, open-source VoIP software based on the
open Session Initiation Protocol (SIP) standard.
Although OpenWengo is a relatively new project,
it already has 400,000 subscribers, and 10,000
new accounts are created every day. Of course,
WengoPhone’s success lies not only in the open-
source software, but also in its competitive rates.

As you would expect, PC-to-PC calls via
WengoPhone are free. Like Skype, WengoPhone
also allows you to call landline and mobile
phones, and at first glance, WengoPhone’s prices
look even lower than Skype’s. For example, Skype
charges approximately $0.021/minute for calling
most European countries and the US, while
Wengo charges roughly $0.010/minute. However,
you should keep in mind that Wengo’s CallOut
service initially was intended for EU customers,
and although non-EU users can freely use the
service, they will be charged additional taxes. In
practice, this means that as a non-EU user you
have to add approximately 15% to the quoted
rates. Still, if you do the math, you will see that
the tax is virtually negligible (15/100*0.010=0.0015).
The good news is that Wengo has a free introductory

offer for new users, so you can try the service
without spending a penny. Even better news is
that the upcoming version of the WengoPhone
software will be able to use other VoIP providers,
which means you can switch to any service 
that offers even better call rates. 

That’s all fine and dandy, but there are some
areas where WengoPhone is not on a par with
Skype. Most notably, Skype offers a few additional
services not available at Wengo such as SkypeIn
(your own Skype phone number that other users
can call) and Skype voice mail. So if you can’t live
without these services, you’d be better off sticking
to Skype until Wengo rolls out something similar.
Skype users also have a large number of available
accessories, ranging from headsets to standalone
phones (you can use a headset with WengoPhone,
but that’s about it).

Wengo operates two Web sites and offers
three versions of the WengoPhone software, so
before you actually install WengoPhone on your
computer, you should know where to go and
what to download. Wengo’s main Web site is at
http://www.openwengo.com. This is the commer-
cial part of the service, where you create and
manage your Wengo account as well as download
the latest stable version of WengoPhone. At the
http://www.openwengo.org Web site, you’ll find
WengoPhone’s source code, developers’ Wiki,
forums and so on. The WengoPhone application is
available in three flavours: a standalone Classic

version, a Firefox extension and WengoPhone NG
(Next Generation).

� WengoPhone Classic is a stable version that
offers a full range of features, including voice
calls, text messaging and text and video chat.

� The Firefox extension lets you use WengoPhone
directly from within the Firefox browser, but its
functionality is limited to voice calls only.

� WengoPhone NG is a bleeding-edge version of
WengoPhone. It is still at an early stage of
development, it’s only available in the source
code form, and some features are still to be
implemented. Obviously, this version is of inter-
est mainly to developers and very curious users.
WengoPhone NG’s killer feature will be the abil-
ity to work with other VoIP providers.

Because WengoPhone Classic is the most
mature and full-featured version of the software,
let’s start with that. Before you download 
and install WengoPhone, check whether your
computer meets the minimum requirements.
WengoPhone requires Linux kernel v2.6 or later,
an ALSA audio subsystem and a Qt 3.3.5 runtime
library. Most modern Linux distributions, such as
Knoppix, PCLinuxOS, SUSE, Mandriva and so on,
have the required components by default. You
also will need a microphone or a headset and,
obviously, a broadband Internet connection.

The Linux version of WengoPhone Classic is
available as both .deb and .rpm precompiled bina-
ries. However, if you are looking for a quick-and-
dirty way to take WengoPhone for a spin, you
might want to install it via klik. If you are running

EExxppaanndd  YYoouurr  RReeaacchh  wwiitthh  WWeennggooPPhhoonnee
With a rapidly growing customer base, WengoPhone is open-source software 
and a standards-based alternative to the more popular Skype. DMITRI POPOV
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Kanotix, simply launch Konqueror and enter
klik://wengophone. For other Linux distributions,
you have to install the klik client first. Press Alt-F2
and type the following command:

wget klik.atekon.de/client/install -O -|sh

Then point Konqueror to klik://wengophone,
and klik will take care of the rest. Later, you can
move the wengophone.cmg file to your home
directory and launch it at any time using the fol-
lowing command (where $HOME is the path to
your home directory):

$HOME/.zAppRun $HOME/wengophone.cmg

The first thing you should do when you launch
WengoPhone is create a Wengo account by press-
ing the Create an account link in the login win-
dow. In the opened Wengo Web page, fill out the
necessary fields, reply to the confirmation e-mail
to activate your account, and you are good to go.

Once you are done configuring your account,
enter your e-mail and password into Wengohone’s
login screen and press OK (tick the Open my ses-
sion automatically check box, so you don’t have to
log in manually every time). But before you make
your first phone call, let’s take a closer look at
WengoPhone’s interface.

The main toolbar contains five buttons (all of
them are self-explanatory): Home, Contact List,
Call History, Add a Contact and Find a Wengo
contact. Also, the Status button allows you to
change your on-line status. Besides the default
values (Online, Away, Offline and Do not Disturb)
you also can define your own custom status.
Simply click in the My Own Status field and enter
a new name. At the bottom of WengoPhone’s

windows, there are four icons. The first button
from the left indicates the status of your Internet
connection. The second button indicates whether
you are using the latest version of WengoPhone.
The third shows whether you have logged in suc-
cessfully using your Wengo credentials. Finally, the
last button lets you check whether the audio sys-
tem is configured correctly. Ideally, all four icons
should be green, indicating that everything is con-
figured properly and WengoPhone is ready.

Quick tip: if you are having trouble getting
WengoPhone connected to the Wengo service,
check whether you are behind a firewall. If you
are, choose Wengo→Configuration and tick the
Safe mode connection check box in the General
section. Usually, WengoPhone does a good job of
configuring your audio and video settings, but if

for some reason these settings require further
adjustments, you can access them via the collapsi-
ble Audio/Video Configuration section. You also
can use this section to adjust the volume of the
input and output devices.

Okay, it’s time to put WengoPhone to some
use and make your first call. Simply enter the
desired phone number (including the country
code) in the input field and press the green phone
button. Alternatively, if you want to call another
Wengo user, you can enter her user name instead.
You are, of course, not limited to voice calls—
you also can send text messages to mobile
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Figure 1. Log in to WengoPhone

Figure 2. WengoPhone’s Main Window

klik://wengophone
klik://wengophone
http://www.tuxmagazine.com


phones, make video calls and chat with other
WengoPhone users. WengoPhone stores all the
called numbers in the Call History section, and
you can call any number on the list simply by
double-clicking on it.

To check your balance and purchase credits,
choose Account→View My Profile and
Accounts→Credit Your Account, respectively.
This opens the My Wengo page, where you
can purchase credits called Wengos, manage

your account settings as
well as view recent calls
and invoices. If you have
multiple Wengo
accounts (which can
come in handy if you
want to keep your pri-
vate and business
WengoPhone expenses
separate), you can
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Figure 3. If you are behind a firewall, make sure that the Safe mode connec-
tion check box is ticked.

Figure 4. My Wengo page allows you to manage your account.

Figure 5. Use the Wengo Directory to find other Wengo users.
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switch between them easily via WengoPhone’s
Account→Open Another Profile.

Once you’ve tested WengoPhone, it’s time to
fill up its address book with some contacts.
Adding contacts to WengoPhone has two major
benefits. First, it lets you call the desired phone

number using the Wengo→Call shortcut.
Second, for all contacts that are also
WengoPhone users, WengoPhone will display
their on-line status, so you easily can see who’s
on-line at the moment and who’s not. To add 
a contact, click Add a Contact and fill out the

form. Wengo also maintains a directory of all
WengoPhone users (you can choose not to 
be listed in it when you create an account),
and you can search it by clicking Find a 
Wengo Contact. Quick tip: WengoPhone 
stores the profile data, including contacts, in 
the $HOME/.wengo directory, and it’s probably
a good idea to back up your profile on a 
regular basis.

As mentioned above, WengoPhone also is
available as a Firefox extension. It offers only the
voice call feature, but it allows you to make calls
without leaving your browser. The Linux version of
the extension is still at an early stage of develop-
ment, and it is a bit unstable. You can install the
extension to try it of course, but as they say,
“don’t use it in a production environment”.

CONCLUSION
WengoPhone may not enjoy the same attention
as Skype, but it does have a lot going for it. First
and foremost, WengoPhone is open-source soft-
ware based on the open SIP standard. It’s also the
first VoIP application that can be installed as a
Firefox extension. More importantly though,
WengoPhone has an active and committed devel-
oper community that is dedicated to bringing you
the best VoIP software out there.�

Dmitri Popov is a freelance writer whose
articles have appeared in Russian, British
and Danish computer magazines. His
articles cover open-source software,
Linux, Web applications and other com-
puter-related topics.
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Figure 6. Using WengoPhone, you can make calls from within the browser.
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It’s simple. You have a laptop that has a wireless
connection and a wired Ethernet port. You have a
desktop machine with only a wired connection.
Why can’t your desktop partake of your wireless
connection? Or, perhaps you have a computer
with a wireless card that’s always plugged in to
the Ethernet network, and you don’t want to
have to invest in an a wireless access point. A sim-
ple piece of software called Firestarter can provide
a solution to these scenarios.

Firestarter is a program that allows you to con-
figure a firewall and Internet connection sharing
on a Linux machine. I warn you now though, if
you’re not very familiar with networks or network
settings, you may lose your Internet connection.
Make sure you have a friend nearby or on the
Internet who can help you get reconfigured if
you do lose your network settings. With that
disclaimer aside, let’s get started.

Of course, to start, you need to install Firestarter.
If Firestarter does not appear in the applications
menu on your distribution, you can see whether it’s
there by typing firestarter on a command line or
in the run command facility on your desktop.

On my Kubuntu Dapper Drake system, Firestarter
is not installed by default, so I used adept to install
the package called firestarter. Use the packaging
management tools of your distro to install it and
run the application. You’ll be asked for the root
password on the machine, and then you should
be presented with the screen shown in Figure 1.

You’ll need to know some things about your
network setup before you proceed through this
wizard. You can use your distro’s configuration
tools to find the necessary information. On my
system, I can figure out what I need to know from
the Network Settings screen, shown in Figure 2.

In Figure 2, you can see that my system defines
my wireless card as eth0, sees that it is currently
connected and that it automatically configures
itself. My wired connection is not plugged in, so it
is shown as disabled. Now, going back to the wiz-
ard, click forward and you are presented with a
screen asking you what your Internet-connected
device is. I selected eth0 and checked the DHCP
check box. Because I do not use dialup, I left
the other check box unchecked. Then, you’ll be
presented with the dialog in Figure 3.

Obviously, check the all-important Enable
Internet connection sharing check box, choose
your other network interface, and then click

IInntteerrnneett  CCoonnnneeccttiioonn  SShhaarriinngg  wwiitthh  FFiirreessttaarrtteerr
A simple GUI application provides point-and-click administration of a firewall and Internet connection sharing utility. KEVIN BROWN

Figure 1. Firestarter’s Wizard

Figure 2. Snooping Kubuntu’s Network Settings

Figure 3. Enabling Internet Connection Sharing
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Forward. You’ll see a screen that says, “The
wizard is now ready to start your firewall.” Leave
the check box checked and click Save.

You might get an error message at this point,
informing you that one of your interfaces is not
ready. Don’t worry; we still have a little more con-
figuration to do. The main window of Firestarter is

shown in Figure 4.
Click the large Preferences button to reach the

Preferences screen. Select the Network Settings
section of the configuration (Figure 5).

Check the Enable DHCP for the local network
check box. DHCP allows your devices to configure
themselves automatically when they connect to
a network.

Next, go ahead and click the Accept button,
and then the Start Firewall button. You should see
the Firestarter main window change to show that
you’ve successfully started the firewall (Figure 6).

If your Internet connection is wired and you
shared the wireless, you should be able to get on
the wireless network with your other devices. If
you’re doing what I did in this situation, you
should be able to connect other devices via a hub,
switch or crossover cable and communicate now.
To encrypt your wireless traffic (always a good
idea), use your distribution’s configuration tools to
enable encryption for your wireless card.

Now, thanks to Firestarter, you can use your
laptop to extend your wired network or create a
wireless access point in a pinch.�

Kevin is 22 years old and currently
lives in Nicaragua with his cat Guapo.
He is proud to use *nix systems exclu-
sively, especially with regards to his
job as a Software Engineer. He likes
helping others learn what he has
learned, whether it be computer

knowledge, playing bagpipes or Spanish.
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Figure 5. Configuring DHCP on Your Local Network

Figure 4. Firestarter’s Main Screen Figure 6. Success! The firewall is active.
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It’s no wonder that 60-million registered users have
chosen Skype’s free PC-to-PC Internet telephony serv-
ice. Its popularity is driven by superb digital call quali-
ty, ease of use, secure encrypted calls and large user
base due to Skype being available for Windows, Mac,
PocketPC and Linux. Skype (rhymes with type) is one
of many VoIP (Voice over Internet Protocol) programs
available for Linux. Other competitors (such as Gizmo)
are equally stable, but for the purpose of this article,
we examine Skype exclusively to see how it meets the
needs of small businesses worldwide.

Skype was recently acquired by eBay and is
being incorporated into the eBay mainframe site,
enabling buyers and sellers to contact one another
free of charge. This acquisition worried some users
who feared that Skype would no longer be a free
service; however, eBay officially has made it known
via the Skype Web site that Skype PC-to-PC calls
will always be free. Thus, eBay’s economic stability
can be only a benefit to Skype, and one certain
benefit to using the Skype service is knowing that
it is rock solid and will continue to be updated and
improved upon. But, if Skype PC-to-PC calls are
free, how does eBay make any money? eBay
makes money from services like SkypeOut and
SkypeIn, which may be of benefit to regular users,
but are of special benefit to small businesses. We
take a look at these services later in this article.

INSTALLATION/COMPATIBILITY
Whichever Linux distribution you use, Skype
offers numerous downloads on its site at
http://www.skype.com/download/skype/linux,
including RPMs for SUSE 9 and newer; Fedora
Core 3 and Mandriva 10.1 and newer; a Debian
package (Xandros, Mepis, Ubuntu and others—
Linspire users can download from CNR); and a
dynamic binary tar.bz2 with or without Qt 3.2
compiled within. The same download page
includes instructions on how to get Skype
up and running on your PC with very
little effort. We found installation to
be quick and painless.

Installation Score: Good

EASE OF USE
To use Skype, you need a high-speed
connection (wired preferably) and a
headset with microphone built-in. You
can purchase a headset from any
computer store that either plugs in
to the sound card (audio and
microphone connections) or USB.
The headset we used for this
review was the Plantronics Audio
USB .45 (Figure 1). It consists of
stereo headphones and microphone
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WWiitthh  SSkkyyppee,,  tthhee  WWhhoollee  
BBuussiinneessss  WWoorrlldd  CCaann  TTaallkk  ffoorr  FFrreeee
With reliable PC-to-PC calls and paid features that allow outgoing and incoming calls from 
traditional landline and mobile phones, Skype may be right for your company. JAY KRUIZENGA

Figure 1. 
Plantronics Audio 
USB .45

http://www.skype.com/download/skype/linux
http://www.tuxmagazine.com


that blocks out most background noise, and it
worked extremely well with Linux. Headsets
also can be purchased directly from the Skype
Web site.

Every Skype user initially must set up a
unique user name and password on the screen
that appears the first time you start Skype
(Figure 2).

You then will want to add a few contacts.
Click on the + inside the green circle at the top

of the main page (Figure 3), and the screen
shown in Figure 4 appears.

The Add a Contact dialog shown in Figure 4
lets you add phone numbers and Skype user
IDs of people you know. If you don’t know
someone’s user ID, you can use the search 

feature on this same screen. Simply type in
your contact’s name, and the Skype system 
will find it for you. To make a call, you merely
click the Contact tab in Skype, highlight the
name of the contact you want to call, and click
the green phone at the bottom of the page
(Figure 5). And, that’s it!

Ease of Use Score: Good
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Figure 3. Click + inside the green circle to add contacts.

Figure 4. Add phone numbers and user IDs 
to Skype.

Figure 2. Select a unique user name and ID at
initial startup.

WITH SKYPE, YOU CAN RECEIVE
CALLS AND/OR PLACE CALLS
TO LANDLINE OR MOBILE
PHONES DIRECTLY THROUGH
YOUR PC WORLDWIDE!
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DOCUMENTATION
The Skype Web site has several good guides,
tips and troubleshooting information.
Documentation does not accompany the Skype
telephony software program, but it is available
from Skype by clicking Help and FAQ. Doing
this automatically directs you to the How to

Use Skype documentation Web page.
Documentation Score: Good

CAPABILITY
As a small- or home-business owner, you no
doubt have customers that are not local who need
to call you. With Skype, you can receive calls
and/or place calls to landline or mobile phones
directly through your PC worldwide! SkypeOut is
a paid service that lets you call any landline or
mobile phone at a very low competitive cost (most
places are less than two US cents per minute). We
found SkypeOut to work very well, and the calls
placed and/or received were of very high quality.
SkypeOut minutes are prepurchased from the
Skype Web site just like a calling card in $10 US
or $25 US increments (or your country’s currency).
For $10 US, you get roughly the equivalent of
eight hours of calls, and for $25 US, you get
approximately 20 hours of call time.

One thing to note: minutes do expire. If you
purchase minutes and fail to make any calls within
180 days, you will lose your minutes. Minutes
expire 180 days after the last call you make.

For businesses needing to make long-distance
phone calls, Skype is a great deal. The two-
cents/minute global rate (most countries) is better
than most landline phone companies. To make a
SkypeOut call, you must dial the full international
number from the Dial tab within Skype. So, a call
placed to the US is +1 (area code) (number). Calls
to the UK start with +44. If you need to know
how to dial a call, the Skype Web site includes a
SkypeOut dialing wizard that shows you exactly
how to dial any number.

The most important non-free benefit of Skype is

SkypeIn, a paid service that allows your business to
get a new Skype phone number so customers world-
wide can call into your PC at their cost. This service
costs a very low $12 US for three months or $38 US
per year, and includes a free voice-mail account.

With SkypeIn, you can have up to ten pur-
chased/rented numbers through Skype. Why would
you want so many? Because the numbers you
choose do not need to be in the area where your
business is located. For instance, let’s say your busi-
ness is based out of Chicago, but it has a lot of cus-
tomers in the London, England area. With SkypeIn,
you can buy a London number at a low cost, which
allows customers in that area to pay local charges to
reach you. How cool is that? Numbers are available
worldwide. The SkypeIn service works the same way
as PC-to-PC calls, so calls placed at your Skype busi-
ness number ring directly into your PC. To answer
incoming calls, simply click the green phone.

We tried both SkypeOut and SkypeIn services,
and they both performed very well. We did lose a
SkypeIn number, but that was because we were on a
wireless network. We found that wireless networks
do not work so well with Skype. You may have dif-
ferent results, however, and other users may have no
problems at all with wireless. Wireless does work,
but it has a latency problem causing received voices
to seem delayed. The Skype site recommends hard-
line DSL or cable hook-ups for best performance.

One final feature is conference calling,
which allows up to five Skype users to converse
simultaneously. We did not attempt this fea-
ture, because the Skype Web site states that
conference calling may be initiated only from a
Windows PC with Skype installed. We certainly
hope that eBay/Skype plans to remedy this.
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Figure 5. Click the green phone to make calls.
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Unfortunately at this time, Linux users
can join in on existing Skype-based
conference calls, but not initiate them.

There is a special high-speed confer-
encing that does work with Linux, and it
is a special collaboration between Skype
and Vapps (another VoIP leader) that
allows you to initiate a 500-person or less
conference call with features that rival
traditional conference-calling hosts,
enabling the moderator to mute/unmute
all calls and callers to mute themselves
within the call. This feature costs five
Euro cents per minute and is billed direct-
ly from each person’s Skype account. We
have not tested this service, but the tools
are available. For more information, go to
http://www.highspeedconferencing.com/
quick.htm.

Finally, we must mention the Skype for
Business Control Panel found at the Skype
Web site. This is a new feature that allows
your home- or small-business bookkeeper
or administrator to take control of all Skype
credit, SkypeIn numbers and Skype voice-
mail accounts, allocating these to individual
people within an organization. The service
itself is free. Inside the Control Panel, you
can select auto top-up for outgoing
SkypeOut calls, so you never need to be
bothered with running out of minutes.

Other Skype benefits that are beyond
the scope of this article include instant
messaging and file transfer from Skype.
These features are fully explained via the
Skype Documentation Web page.

Skype is a well-rounded, stable telepho-

ny system that can be used for inexpensive
calls to and from traditional landline and/or
mobile phones. It is not meant to be a
complete replacement for traditional phone
systems and may not be used for emer-
gency purposes; however, as an accompa-
niment to these traditional systems, Skype
is a great deal and benefit to home and
small businesses with existing customers
outside of the local area. We fully recom-
mend Skype for the services it provides and
the value found in the program itself.

A few features are unavailable to Linux
that keep us from giving the Skype pro-
gram full points for capability:

� Call forwarding allows Skype calls to be
transferred to landline or mobile
phones and works only in Windows.

� Video calling works only in Windows.

� Conference calling initiation works only
in Windows.

� Skype Zones is a service that allows
access to Skype and the placement of
calls from more than 18,000 Internet
hot spots around the world and works
only with Windows.

We certainly hope and expect these
shortcomings to be remedied in the near
future—right Skype?

Capability Score: Good (It would
be excellent if all features were made
available for Linux.)

SUPPORT
Other than the previously mentioned user
guide, if you need support for Skype, you
can submit a support request on the Skype
Web site at http://support.skype.com.

Support Score: Average (There’s no
phone support.)

CONCLUSION
Skype could be of great benefit to your
home or small business due to the paid
services that will save money on long-dis-
tance calls. Although all features are not
yet available for Linux, there are enough
features to make this telephony program
useful. The Skype Web site recently pub-
lished research findings that 30% of the
60-million registered users utilize Skype
for work purposes. That’s 18 million busi-
ness users! Skype is a revolutionary pro-
gram that is changing the way business is
being conducted throughout the world.�
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INSTALLATION: Good

EASE OF USE: Good

DOCUMENTATION: Good

CAPABILITY: Good

SUPPORT: Average

FINAL SCORE: Good

Jay Kruizenga is a for-
mer Marine who started
using computers with
the Commodore 64 in
the service. Dissatisfied
with Windows, he start-
ed looking for viable
options and discovered
Linux in the late 1990s,
which he now uses
exclusively for the opera-
tion of a small home-
based Internet business.

http://support.skype.com
http://www.highspeedconferencing.com/quick.htm
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It doesn’t matter whether you’re about to head
into summer and its many weekends at the
beach, or into winter, with your skis cutting into
fresh powdered snow: if you try to use your digi-
tal camera during seasonal recreational activities,
there’s a good chance it’s going to get wet. And
as we all know—sometimes through sad experi-
ence—electronics and water do not go well
together. Until now, anyhow.

For those who love to mix water with photog-
raphy, there have been a number of enclosure
products, allowing you to take your favourite
point-and-shoot camera and lock it into a clear
plastic case to protect it from the elements. The
big problem is that these cases tend to be some-
what expensive and bulky, and it tended to be
hard to use any functions on the camera beyond
pressing the shutter, because the menu buttons
were often too small for the clunky waterproofed
contraptions to handle with any agility.

Now there’s a new generation of cameras that
are “waterproof” right out of the box, which means
you don’t have to worry about carting around a
bulky enclosure in addition to the camera. In fact,
the pair of waterproofed cameras I looked at were
pretty much the same size as the rest of today’s com-
pact point-and-shoot cameras. The only noticeable
difference is that with waterproofed cameras, the
lens is completely enclosed in the body of the cam-
era behind a protective panel, and all of the panels
that hide memory cards, batteries and other connec-
tors feature rubberized seals and locking mecha-
nisms to prevent them from opening accidentally.

You may have noticed that I put waterproof in
quotation marks at the beginning of the last para-
graph, and that’s to underscore a misconception.
Waterproof doesn’t mean you can use something
underwater indefinitely. There are varying levels of
waterproofing, measured with a rating typically
labeled JIS, followed by a number, or IPX, followed
by a number. This rating means the product has
been certified for use underwater, but only to a cer-
tain depth and for a certain length of time—go any
deeper or stay underwater any longer, and water
will start to seep through the seals. The typical
depth and time for a camera listed as JIS8/IPX8 is
between five- to eight-feet deep for up to 30 min-
utes. In other words, that’s enough time for a quick
swim in shallow water, but not enough to take the
camera on an extended swim or scuba dive.

Another word of caution for those thinking of
getting a waterproofed camera is that after you
leave the water, you have to wait a while before
opening your camera’s access doors to make sure
the area around the rubberized seals is dry. If you
run out of the water and immediately open up
the camera’s USB door so you can download your
pictures to a computer or swap the battery, you’re
likely to cause damage to the camera when the
water seeps into the electronics.

With waterproof cameras, you also want to
avoid giving the camera any unnecessary shocks,
like dropping it on a hard surface or hitting it
against a table. Although the camera’s electronics
may be able to handle it, it may warp or loosen
the camera’s protective doors, causing them to let

water through much more quickly than usual.
If you’re taking the cameras underwater often,

you’ll want to make sure you clean the cameras
regularly with a soft cloth and soapy water. The
crunge built up by salt, chlorine or dirty water can
compromise the quality of your pictures or even
damage the camera.

Now, with those cautions out of the way, on to
the cameras. Both cameras I looked at this month
are USB mass storage class devices, which means
you should be able to plug them in to your Linux
box and copy the images over in exactly the same
way you would from an external hard drive or
USB memory key. If your system already recog-
nizes those types of devices automatically, these
cameras will work just fine.

PENTAX OPTIO WPI

http://www.pentax.com
$250 US

The Optio WPi is the latest waterproofed point-and-
shoot model from Pentax, and it’s a compact little
marvel. At 105 x 51 x 24 mm, it’s already smaller
than a lot of other garden-variety point-and-shoot
digital cameras out there. Impressively, this one
manages to include a 6 megapixel image sensor and

GGaaddggeett  GGuuyy::  IInnttoo  tthhee  DDrriinnkk
Planning on a summer vacation at the beach? If so, you’ll want to check out this month’s 
Gadget Guy to capture those snorkeling adventures digitally. SEAN CARRUTHERS

Pentax Optio WPi

http://www.pentax.com
http://www.tuxmagazine.com


a 3x optical zoom lens. As the entirety of the lens is
tucked in behind a clear protective panel, the lens
components are all fairly small, and consequently
the image may not be quite as crisp as images
taken on 6 megapixel models with larger optics
(both lens and sensor). That said, the camera still
takes great images on both sides of the waterline.

The Optio WPi has 10.5MB of built-in memory,
which is good for about three shots at the highest
resolution, or 16 seconds of video at 320x240 reso-
lution. You’ll definitely want to invest in more
memory for the camera if you’re planning to use it
for longer periods—and why wouldn’t you want
to, if you’re planning to take it underwater? Luckily,
the camera also accepts SecureDigital cards.

The WPi also features a really nice menu system
with a lot of powerful features, especially considering
the camera’s modest price. Not only can you do some
editing on the camera, including cropping, resizing
and rotation, you also can do automatic red-eye cor-
rection on the camera. Even better, if you mistakenly
delete an image, you can go into image recovery
mode and get that image back, provided you haven’t
already recorded over it with another shot.

The spec sheet for this model says you can
keep the camera underwater at a depth of five
feet, for up to 30 minutes.

OLYMPUS STYLUS 720 SW

http://www.olympusamerica.com
$400 US

Olympus’ Stylus line of digital cameras has long
featured “weather- resistant” casing, allowing you
to take them outside while it’s raining without
having to worry too much about damaging them.
Anyone that managed to dunk one of those cam-
eras in a puddle can probably tell you that’s not

the same thing as “waterproof”, however. Luckily,
Olympus has taken the next step and released a
camera that actually can go into that puddle—or
the river, the lake or pool.

The Stylus 720 SW is a bit pricier than the Pentax
model, for a couple of reasons. First, it has a higher-
resolution sensor (7.1 megapixels), for larger pictures.
Second, it comes with a 2.5-inch LCD viewfinder on
the back, making it easy to line up the shots even if
you’re underwater. Third, it not only comes with
waterproofing, it also has shock protection that pro-
tects it for drops of up to five feet.

It’s worth noting that although the camera is
rated for depths of up to 10 feet, the manual
doesn’t list a duration; however, the camera meets
the IPX-8 standard, which specifies up to 30 min-
utes at a depth of 8 feet, so at 10 feet it’s probably
a bit less than the full half hour. (Unfortunately, as
I don’t have the money to replace the camera, I
couldn’t fully test out this theory by keeping it
underwater for that long.)

The Stylus also features an extensive menu sys-
tem with a lot of different scene modes for proper
shooting in a variety of locations. There are 24
shooting modes, including four specifically dedi-
cated to underwater photography, scene modes
dedicated for night shooting, fireworks, low light,

items behind glass, cuisine, documents, sand and
snow, and more. The camera even has a digital
image stabilizer, for more steady shots in low-light
or high-motion situations.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six years
at Canada Computer Paper, first as
Products Editor at The Computer and later
at HUB Digital Living magazine. As a free-
lancer, he has written for the Globe and
Mail, http://globetechnology.com, HUB

Digital Living, Computer Dealer News, Homefront and CE-Biz.
Although a relative newbie with Linux (SUSE, thank you very
much), he has extensive experience with tech gadgets of all sorts
and is enjoying figuring out which ones are compatible with Linux.
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Olympus 
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Both Cameras
under Water
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The brother of Neverball, Neverputt uses the same
engine to create a game that is fundamentally dif-
ferent, but feels quite similar—addictive, yet infu-
riating! The concept of the game is fairly simple,
minigolf for you or several mates, but the result-
ing game play is a lot more complex. With a fully
3-D environment and a real-time physics engine,
both these elements are utilized to create game
play concepts that basically have been nonexistent
in minigolf games previously.

The controls are very simple. When it’s your
turn, swing the mouse around to aim, and move
the mouse backward or forward to adjust the
power. The simplicity ends there, as the environ-
ment is unforgiving, with plenty of complex
features. Endless ramps, traps in the ground and
moving objects abound—ranging from simple
obstacles, to traps for throwing you into space
and even moving platforms.

Often angled parts of the ground are deceptive
and look quite easy, but there’s usually a lot of
thought put into each level, and a trap always
lurks in each. The large use of ramps requires a
good degree of judgment: too little power, and
the ball trickles back down; too much power, and
it literally flies off the course into space (going off
the edge brings a one stroke penalty)!

Neverputt shares some features from Neverball,
such as warp platforms, which instantly transport

the ball to another area on the course. An inter-
esting game play dynamic is the use of triggers,
where the ball running over a pad on the ground
sets off something else in the level, usually moving
an obstacle or something like that. Care has to be
taken with triggers, as making contact with them

more than once sets each pad off more than
once. So take note of any surrounding walls, and
use them to bounce the ball around the trigger.

The courses don’t really follow a standard pro-
gression of difficulty. Easy presents a nice, tradi-
tional course at the beginning, and then starts to

NNeevveerrppuutttt
Have the urge to hit the links, but Mother 
Nature has other plans? Why not settle for 
a quick round of Neverputt? JOHN KNIGHT
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Figure 1. Interesting Use of Triggers on a Course Designed around the Letter K
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get wacky. Medium starts out a little crazy, but is
actually bit more toned-down (though more frus-
trating) than the easy level. Hard is based around
the alphabet, and actually isn’t that much more
difficult, but it is, of course, much longer with 26
holes (one for each letter), and it is probably the
most interesting of the courses.

With the same engine as Neverball, the graphics
are still quite pretty, but for some reason, the color
seems subdued. The colorful blue skies, clouds and
cartoony animations seem to have been done away
with, making things generally more drab and func-
tional. I’m not sure which was made first, Neverball

or Neverputt, but if
Neverputt was made
first, this would explain
why the graphics in
Neverball are much
friendlier with less con-
sideration given to
Neverputt. A fault that
Neverputt shares with its
brother is graphical
glitches like a shadow
that is cast through
receding platforms and
some occasionally dodgy
camera angles. These
criticisms aside, it still
looks pretty good for an
open-source game.

As these two games
share the same engine,
they also share the same
system requirements, so
you need a 3-D card.
Although, as the con-
trols aren’t as hypersen-

sitive as Neverball, you actually can get away with
having a slower machine, as performance won’t
have a direct influence on the controls.

In the end, this game is definitely a must-try,
especially for gaming masochists, because it
comes straight from the gaming sadist masters! I
find this game most enjoyable with a few mates
and a few albums playing in the background,
but single player is still enjoyable. If you already
have Neverball installed, Neverputt should have
come with it, and like Neverball, there’s a
chance it’s already installed on your system.
Have a peek through the menu, or try the 

command neverputt. The Neverputt Web site
is at http://icculus.org/neverball (same site as
Neverball). Happy golfing! Fore!�

John Knight is a 21-year-old, rock-climb-
ing, Japan-loving megalomaniac, trying
to take over the world from his bed-
room via his keyboard. He spends most
of his time tinkering with MPlayer and
headbanging to his MP3s.
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Figure 2. The Well-Used Aspect of Angles in Neverputt and the Occasional
Epic Setting

TIPS

Features
You will be repeating a course many times over,
and taking the same shots. Take note of the
triangular notches on the side walls and the
amount of power you’re using. Eventually, you
should be able to repeat certain shots perfectly,
by counting how many notches along the wall to
aim for and rebound off, and so on.

Pixels
When lining up shots at features like flags, if you
want to see whether it’s straight, try looking at
the jagged edges made by the pixels. Generally,
you’ll be able to swing the camera around so
that the edge of the feature is perfectly straight,
instead of blocky and jagged (running in a lower
resolution should help).

Who Dares Doesn’t Win
That fancy shot that you’re about to take at an
angle off a feature won’t pay off unless you’re a
veteran. Play it safe to get par, then try to be
fancy next game.

http://icculus.org/neverball
http://www.tuxmagazine.com
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